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Formai, technikai és módszertani követelmények a prezentáció 
elkészítéséhez 

 
 

1. Az első oldal tartalmazza: az intézmény pontos nevét, a tantárgy nevét, a dolgozat 
címét, a mentor nevét, a jelölt nevét, a város nevét és a dátumot. Automatikus 
időzítéssel jelenjen meg (20 másodperc), az animációk egy időben induljanak. 
minta: http://blog.namesztovszkizsolt.com/wp-
content/uploads/2009/10/powerpoint/elsooldal.ppt  
 

2. Használjunk helyes színeket és éles kontúrokat (főleg a háttérszín és szöveg színe 
között)! 

 
3. Használjuk az Arial vagy a Times New Roman betűtípust (másik számítógépen 

sem fog a szöveg változni – alap betűtípusok - kompaktibilitás). A betűméret ne 
legyen kisebb 24-es pontnagyságtól! Az előadóterem nagyságától függően 
használhatunk 28-as, 36-os és 48-as betűméretet Álljunk 3 m távolságra a 
számítógép monitorjától. Ha a PowerPoint diák szövege még innen is jól 
olvasható a betűk megfelelő méretűek. Ha 3 méterről nézve a mondatok 
összemosódnak, a betűk túl kicsik. Figyelem! Az embereket semmi sem idegesíti 
jobban, mint egy rosszul látható és rosszul hallható prezentáció, előadás! 

 
4. Egy oldalon legyen kép és szöveg is, de gondoljunk az „egy dia, egy gondolat” 

elvre is, valamint arra hogy a dia 3 másodperc alatt „értelmezhető” kell hogy 
legyen. 

 
5. A bemutatónk tartalmazzon elkülönölő részeket (legalább három rész), amelyek 

külön háttérrel és oldalszámozással rendelkezzenek (ismétlés, képtár, feladatok, 
fő rész, mozgóképek, stb.) 

 
6. Kapjon helyet minden dián a visszafelé mutató (Előző dia – Previous Slide) és a 

tartalomjegyzékre mutató hiperlink. A bemutatónk tartalmazzon 
tartalomjegyzéket, ismétlést és feladatokat, amelyeket hiperlinkek (akciógombok) 
segítségével építünk fel. 

 
7. A szövegek és a képek helyét jelöljük meg. Kerüljük a túlzsúfolt képeket és 

diákat! Inkább használjunk több képet/diát. Egy diára egy gondolat, fogalom 
kerüljön, hiszen a diák korlátlan mennyiségben állnak a rendelkezésünkre. A 
képeket számozzuk meg, ha csatolunk hozzá hangot, akkor ezt tüntessük fel (diák 
és a képek megszámozása módszertani szempontokból fontos). 

 
8. Törekedjünk mozgófilmek és hangok használatára (természeten, ha témánk ezt 

lehetővé teszi). A videók és a hangok kattintásra induljonak! 
 

9. Alkalmazzunk animációkat és áttűnéseket (megfelelő következetességgel), 
diagrammokat, táblázatokat, WordArtokat, árnyékolásokat és térhatásokat. 

http://blog.namesztovszkizsolt.com/wp
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10. Az animáció vagy a grafikai megjelenítés sosem legyen az áttekinthetőség kárára 

(pl.: az animáció során ne haladjanak át a szövegek, képek másik objektumok 
felett) 

 
11. Mondanivalónk alkalmazkodjon a célcsoport értelmi szinjéhez. Ha új fogalmakat 

használunk, magyarázzuk meg azokat. Egy oldal egységei (mondatok, képek) 
külön klikkelésre jelenjenek meg (fokozatosság – lehetőség a beszélgetésre). 
Lapozzuk fel a többi tantárgy tankönyveit is (ötletek, gyermekek szókincse és 
értelmi szintje). 

 
12. Keressük a kapcsolatot (korrelációkat) más tantárgyakkal: zene, magyar nyelv, 

képzőművészet, stb. Olvassuk át más tantárgyak, valamint előző évek programját, 
valamint tanlünyveit. 

 
13. Teszteljük bemutatónkat (a saját gépünkön kívül), még legalább egy 

számítógépen. Használjuk a PowerPoint Előkészítés CD-hez lehetőségét! 
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PowerPoint lehetőségei az oktatásban 
 

A PowerPoint a Microsoft Office irodai programcsomag része, amely grafikus 
bemutatók készítésére szolgáló szoftver (bemutató-  vagy prezentációkészítő). Ezek a 
bemutatók voltaképpen az iskolai írásvetítőket válthatják fel az iskolákban. Használata 
viszonylag egyszerű, hiszen nagyszámú, előre elkészített sablonnal dolgozhatunk, 
valamint sok művelet hasonlít vagy megegyezik a programcsomag más szoftvereiben 
megtanultakkal (Word, Excel). 

Az írásvetítőkkel szemben nagy előnyük, hogy az elkészített bemutatónknak 
bármely része szabadon módosítható, nem kell időt töltenünk a fólia törlésével, 
újraírásával, az esetlegesen elpiszkolt részek kijavításával. Az ilyen szoftverek 
alkalmazása (és egyáltalán az iskolai írásvetítők használata) koncentráltabb óravezetést is 
lehetővé tesz a tanár számára, gyorsabb haladást és érdekesebb magyarázatot is nyújthat a 
gyermekeknek.  

Az órák tervezése azonban nagy körültekintést igényel. Tisztában kell lennünk a 
gyerekek számítógépes tudásának szintjével, a hozzáállásukkal, valamint vizuális 
érettségével.  Elkészült anyagot – az időzítést, helyesírást, a stílust – szigorúan ellenőrizni 
kell, mivel végülis írásos anyagról van szó. Természetesen meg kell győződnünk a 
program technikai működéséről is. 

A megfelelő igényességgel elkészített bemutató akár a tankönyv egy részét is 
kiválthatja. Emellett a digitális tananyagok legnagyobb előnye a tankönyvekkel szemben 
az interaktivitás, a saját tempóban történő haladás, a linkelések egyszerűsége (klikkel 
nyitjuk meg, nem kell begépelni), valamint a hipertextuális és multimediális támogatás 
(tetszőleges haladási irány-tartalomjegyzék, videok és hangok használata). Ha nem 
vagyunk elégedettek a rendelkezésünkre álló tankönyv megjegyzéseivel, vagy éppen más 
versekre, tematikus egységekre, motívumokra teszünk nagyobb hangsúlyt, az általunk 
elkészített anyagot a gyerekek rendelkezésére bocsáthatjuk, feltölthetjük az iskolai 
hálózatra, esetleg az általunk elkészített honlapra. (Ez utóbbit nagymértékben 
megkönnyíti, hogy az említett program varázslójával készíthetünk webes alkalmazást.) 
Persze, mondhatnánk azt is, hogy mindezt egy szövegszerkesztővel is megtehetnők. 

Azonban bemutató típusú programok legnagyobb előnye (a szövegszerkesztő 
programokkal szemben) a multimédiás lehetőségek kihasználásában rejlik. Mivel 
nemcsak szöveget, hanem filmet  (avi és mov formátumban), hangot (wav és mp3) 
formátumban, és képeket egyaránt tartalmazhat, így a tanulók több érzékszervére 
hathatunk, s így a tanulás is hatékonyabban történhet mint az egyszerű írásvetítő 
esetében. Lehetőség van tehát a szöveg olvasására s egyidejű meghallgatására, 
szövegértelmezések lehetőségek szerinti azonnali elolvasására (erre találták ki a 
PowerPoint hiperlinkes megoldásait, mely a diakockák közti kapcsolatokat teszi 
lehetővé), a tanulók által nem értett szavak elmagyarázására azáltal, hogy az előbb 
említett megoldással élve a tanuló igénye szerint kérjen magyarázatot. A PowerPointba (a 
2000-es verziótól kezdve) megnyithatunk Macromedia Flash fájlokat, amelyek 
legnagyobb részt animációk. Az állóképeket megjelenését és eltűnését is animálhatjuk, 
amely ugyancsak a PowerPoint sajátossága. A bemutatóink diákból (slide) állnak.  

Az is világos minden tanár számára, hogy a vázlatot nem diktáljuk. Nos, erre is 
használhatók a bemutatók. Az órák egyes részleteiben az elhangzottakat rögzíteni kell 
részösszefoglalás formájában is. Erre is felhasználható a program. Előnye a világosság és 
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áttekinthetőség mellett az, hogy a tanuló helyesírása is javulhat, írásképéről nem is 
beszélve. 

A PowerPoint  nemcsak bemutató jellegű prezentációk készítésére alkalmas, 
hanem olyan prezetnáció vagy prezentációcsomag készítésére is, amelyeket a tanulók 
önállóan dolgozhatnak fel.  

 
Alapműveletek 

 
 Szeretnénk lépésről-lépésre, az alapoktól kezdve, a PowerPoint  elemeit és 
parancsait bemutatni. Segítséget és gyakorlati tanácsokat adni a prezentációk 
elkészítéséhez, amely iskolai óránkat, előadásunkat teheti érdekesebbé, élvezetesebbé. 
Alapul a PowerPoint  2010-es kiadása szolgált, amely a legelterjedtebb manapság a 
személyi számítógépeinken. A programot magyar nyelvre is lefordították, munkánkban 
az angol és a magyar kifejezéseket is feltüntettük (mivel a magyar szakszavak a 
számítástechnikában még nem terjedtek el eléggé). 
 A Microsoft Office programcsomag, a 2007-es kiadásától kezdődően, a 
hagyományosnak számító legördülő menüket Menüszalagokkal (Ribbon) 
helyettesítették, a jobb kezelhetőség érdekében. Az utasítások képek formájában (vagy 
kép és szöveg) jelentek meg, az „egy szó többet mond száz szónál” elvet követve, 
valamint csoportokat alkotnak. Ezen újítások mellett megjelent a Minipult (Mini 
Toolbar), amely a leggyakrabban használt utasításokat tartalmazza, és kijelölés vagy 
jobb klikkelés után válik láthatóvá. A 2007-es verziótól eltérően a 2010-es verzióban az 
Office gomb helyett újra a Fájl (File) felületen találjuk a kulcsfontosságú műveleteket 
(Mentés, Mentés másként, Megnyitás, Nyomtatás, Beállítások, stb.).  
 
A szoftver futtatása 
 

Legegyszerűbben a Start menü All Programs > Microsoft Office > Microsoft 
Office PowerPoint 2010 parancsának segítségével futtathatjuk. 
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A program részei 
 

A futattás után a következő kép jelenik meg a kijelzőnkön: 
 

1. kép 
A PowerPoint indítása után megjelenő kép 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

  
 
 

Az ablak címsorában a készülő bemutató nevét láthatjuk. Az ablak címsora alatti 
menüben a PowerPoint menüszallagainak, valamint ezek füleinek listáját találjuk 
kategóriák szerint csoportosítva. A következő csoportok találhatóak meg itt: Fájl (File), 
Kezdőlap (Home), Beszúrás (Insert), Tervezés (Design), Áttűnések (Transitions), 
Animációk (Animations), Diavetítés (Slide Show),  Korrektúra (Review), View 
(Nézet).  Folyamatosan látható gombként megtalálható (a jobb felső sarokban) A 
menüszalag összcsukása (Minimize the Ribbon), amely CTR + F1 gombkombináció, 
valamint Segítség (Help), amely F1-es gombbal hívható elő. Ezen fülek mellett (az egyes 
elemekre duplán klikkelve) megjelenik a Formátum (Format) szalag, amely az aktuális 
elemek szerkesztési lehetőségeit kínálja fel. 
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2. kép 
Formátum menüszallag (képre alkalmazva) Segítség és a A menüszalag összcsukása 
gombokkal 
 
 

 
 

 
 
 

A munkaterület három ablaktáblából áll: a Vázlat, a Dia és a Jegyzet 
ablaktáblából. A Vázlat ablaktáblán az előadás képkockáinak szövegét vagy a képkockák 
kicsinyített mintáit láthatjuk. 

A Dia ablaktáblán az aktuális dia tartalmát szerkeszthetjük. Az Előadói jegyzet 
ablaktáblán az aktuális diához kapcsolódó megjegyzéseket gépelhetjük be, amelyet 
kivetítés alkalmával az Előadói nézet (Presenter View) bekapcsolásával jeleníthető 
meg. Az Állapotsoron néhány, az aktuális bemutatóval, illetve nézettel kapcsolatos 
információt olvashatunk le (diák száma, alkalmazott téma, a bemutató nyelve).  
 
Program beállításai 
 
 A program beállításai a következő elérési útvonalon érhető el: Fájl szalag, 
Beállítások opció File > Settings. Ezen a részen (a többi Office alkalmazáshoz 
hasonlóan) a program működésére vonatkozó beállításokat tudjuk módosítani, mint 
például a Minipult megjelenítése-eltüntetése, Színséma, mentésekre vonatkozó 
beállítások (alapértelmezett fájltípus, alapértelmezett mentési mappa, automatikus 
mentés),  a Menüszalag és a Gyorselérési eszköztár testreszabása. A menüszalag és a 
gyorselérési eszköztár testreszabható a jobb klikk segítségével megjelenített helyi 
menüből is.  

A beállítások részben a mentés menüpont alatt a felhasznált Betűtípusok 
beágyazása a fájlba (Embed fonts in the file). Ez az opció akkor hasznos, amikor 
különleges betűtípusokat használtunk, amely egy másik számítógépen (amelyiken be 
szeretnénk mutatni) valószínűleg nincsenek telepítve. Ilyen betűtípusokat az internetről 
tudunk letölteni (ajánlott keresési kulcsszavak: free font, free font download, free 3d 
fonts, beautiful font download). A fájlok ttf vagy otf kiterjesztésűek. A letöltött fájlokat a 
Vezérlőpul Betűtípusok (Control Panel > Fonts) mappájába kell másolni, ezzel 
automatikusan telepítésre kerülnek.  Eltávolításuk ezen fájlok törlésével történik meg. 
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3. kép 
Betűtípusok beágyazása a Mentés panelen 
 

 
 
 Ez a művelet a fájl növekedését eredményezi (a bemutatott példán 42 kb-ról 478 
kb-ra), de viszont biztosak lehetünk benne, hogy a prezentáció betűi a kívánt módon 
jelennek meg. Ellenkező esetben (mint ahogyan a 4. képen is látható) a szoftver egy 
hasonló betűtípust használ a szöveg megjelenítésére. 
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4. kép 
Egy bemutató különleges betűi egy másik számítógépen megnyitva a karakterek 
beágyazása nélkül és a karakterek beágyazásval 
 

 
 
FELADATOK 
 
1. Adjuk hozzá a gyorselérési eszköztárhoz a Nyomtatási kép és nyomtatás (Print 
Preview), valamint a Megnyitás (Open) ikonokat. 
2. Állítsunk az automatikus mentést 1 percre, és adjuk meg alapértelmezettnek azt a 
mappát, amelyet az órák alatt használunk. 
3. Telepítsünk a megadott karakterkészletekből egy tetszőlegeset. Alkalmazzuk ezeket a 
betűket a bemutatónkba, majd ágyazzuk be őket a fájlba. 
 

Fájl szalag beállításai 
 
 A fájl szalag tartalmazza a kulcsfontoságú műveleteket. A szalag tartalma a 2007-
as PowerPoint szoftverekben az Office gomb alatt található meg. Ha átváltunk erre a 
szalagra, akkor legutóbb használt (megnyitott) bemutatók listáját látjuk a Legutóbbi 
bemutatók (Recent Documents) alatt. 
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5. kép 
Fájl menüszallag (Legutóbbiak opció) 
 

 
 
Új dokumentum 
 

Új dokumentum létrehozásához legegyszerűbb a Fájl szalag Új parancsával 
hozható létre (File > New). Új dokumentum a Ctrl + N billentyűk egyidejű lenyomásával 
is létre tudunk hozni. Az opció engedélyezése után az új dokumentum kinézetét és 
elrendezését kell meghatározni. 
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6. kép 
Fájl menüszallag (Új dokumentum) 
 

 
 
 

Mentés  
 

A bemutatókat későbbi felhasználás céljából elmenthetjük háttértárunkra. Az 
elmentett bemutatókat később újra megnyithatjuk, módosíthatjuk, levetíthetjük, illetve 
más bemutató alapjaként felhasználhatjuk.  

A bemutatók mentéséhez használjuk a Fájl szalag Mentés parancsát (File > 
Save). A Ctrl + S gombkombinációval is mentést tudunk kezdeményezni. Ha a Mentés 
gombbal egy korábban már elmentett bemutató mentését kezdeményezzük, akkor az új 
változat automatikusan felülírja a bemutató korábbi példányát. Ha egy újonnan 
létrehozott bemutató mentését kezdeményezzük, akkor a megjelenő Mentés másként 
párbeszéd panelen meg kell határoznunk, hogy a bemutatót milyen néven, és melyik 
mappába mentjük. 

A Fájl (File) szalag Mentés másként (Save As) parancsának használatakor 
minden esetben lehetőségünk van a mentésre szánt bemutató nevét, valamint a célmappát 
megváltoztatni (gyorsgomb F12). Ebben az esetben a bemutató előző példánya a korábbi 
néven és helyen változatlanul megmarad. A Mentés másként panelen először határozzuk 
meg a célmappát Hely (Save in), majd a Fájlnév (File name) mezőben adjuk meg a 
bemutató nevét. A művelet befejezéséhez kattintsunk a Mentés (Save) gombra. 

A mentés másként ablakban a Fájltípus (File name) legördülő menüben 
kiválaszthatjuk a menteni kívánt dokumentum típusát.  
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7. kép 
A Mentés másként panel 
 

 
 
 

1. táblázat 
Lehetséges mentések jellemzői a PowerPoint 2010-es szoftverben 
 

Név Kiterjesztés Leírás 

PowerPoint 97-2003 
bemutató 
(PowerPoint 97-2003 
Presentation) 

ppt 

Módosítható és levetíthető prezentáció, a 
2003-as és a régebbi PowerPoint 
programok alapértelmezett állománya. 
Manapság kompatibilis mentésként 
alkalmazzák. Ha 2007-es vagy 2010-es 
Office-ban szerkesztünk ilyen fájlokat, 
akkor a kompatibilis mód (Compatibility 
Mode) olvasható a programablak 
fejlécében a fájlnév mellett. 

PowerPoint-bemutató 
(PowerPoint Presentation) pptx 

Módosítható és levetíthető prezentáció, 
leggyakrabban alkalmazott fájltípus. ZIP 
tömörítéssel csomagolt, ezért kisebbek 
mint a ppt fájlok. A 2007-es és a 2010-es 
PowerPoint alapértelmezett állománya. 

PDF pdf 
Szöveges, nem módosítható formátum 
(csak a prezentáció szövege kerül 
mentésre, az animációk, a hangok és a 
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videok elvesznek). 

PowerPoint 97-2003 
sablon (PowerPoint 97-
2003 Template) 

pot 

Új fájlok létrehozásához, illetve már 
meglévő fájlok teljes grafikus felületének 
(háttér, színek, elrendezés) cseréjére 
használjuk. Kompatibilis mentéssel 
létrehozott fájl. 

PowerPoint-sablon 
(PowerPoint Template) potx 

Új fájlok létrehozásához, illetve már 
meglévő fájlok teljes grafikus felületének 
(háttér, színek, elrendezés) cseréjére 
használjuk. 2007-es vagy 2010-es 
PowerPointban létrehozott fájl. 

PowerPoint  97-2003 
diavetítés (PowerPoint 97-
2003 Show) 

pps 
Nem módosítható, csak vetíthető 
fájlformátum. Kompatibilis mentéssel 
létrehozott fájl. 

PowerPoint-diavetítés 
(PowerPoint Show)  ppsx 

Nem módosítható, csak vetíthető 
fájlformátum. 2007-es vagy 2010-es 
PowerPointban létrehozott fájl. 

GIF fájlformátum 
(format), JPEG 
fájlformátum (format), 
PNG fájlformátum 
(format), TIFF 
fájlformátum (format) 

gif, jpeg, png, 
tiff 

Prezentáció elmentése különböző 
képformátumokba. A mentés gomb 
lenyomása után meg kell határozni, hogy 
az összes diát szeretnénk menteni, vagy 
csak az aktuálisat: A bemutató összes 
diaképét exportálni szeretné vagy csak az 
aktuális diát? (Do you want to export 
every slide in the presentation or only the 
current slide?). Az így elmentett képek 
elveszítik a PowerPointra jellemző 
sajátosságokat (animációk nem mentődnek 
el).  

Vázlat/RTF (Outline/RTF) rtf 

A prezentáció mentése szerkesztehető 
szöveges fájlba (az opció akkor működik 
ha a prezentáció szövegét a felkínált 
helyőrzőkbe írjuk).  

 
Fontos:  
 
§ A 2007-es és a 2010-es fájlokat (docx, xlsx és pptx) a 2003-as Office programok 

nem tudják megnyitni. Ha olyan számítógépen szeretnénk megnyitni a 
dokumentumainkat, amelyen 2003-as Office van telepítve, akkor használjuk a 
kompatibils (97-2003) mentési módot (doc, xls és ppt fájlokat hozunk létre). 
a sablon. 

§ Sablonok mentésénél (a mentési mód kiválasztása után) a PowerPoint átvált a 
sablonok tárolására fenntartott mappára (C:/Documents and Settings/User 
name/Application Data/Microsoft/Templates mappa alapértelmezetten) 
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Megnyitás  
 
Egy korábban létrehozott bemutató megnyitásához a Fájl (File) szalag Megnyitás 

(Open) menüpontjára kell klikkelni vagy a Ctrl + O gombkombinációt használni. Az 
utolsó néhány prezentáció megnyitható a Legutóbbi bemutatók (Recent Documents) 
opcióval. 

 
Kilépés  

 
Ha befejeztük a munkát, bezárhatjuk a bemutatót a Fájl szalag Kilépés 

parancsával (File > Exit) vagy a bemutató ablakának bezárás gombjával (Alt + F4). 
Amennyiben a bemutató még nem mentett módosításokat tartalmaz, a PowerPoint 
felkínálja a mentés lehetőségét. Ha az Igen gombra kattintunk, a PowerPoint a Mentés 
parancs segítségével elmenti, majd bezárja a bemutatót (Do you want to save the 
changes you made to Presentation). 

Ha a bemutató korábban még nem volt elmentve, vagy a bemutatót csak olvasásra 
nyitottuk meg, a Mentés másként párbeszéd panel jelenik meg.  

 
8. kép 
A bezárás előtt megjelenő ablak (ha a bemutató tartalmaz nem elmentett részeket) 
 

 
 
 
Nézetválasztás  

 
A nézet menüszalagon találhatóak a megjelenítésre vonatkozó beállítások, mint 

például a diák elrendezése (bemutatónézetek), a Vonalzó, a Rácsvonalak és a 
Segédvonalak megjelenítésére és eltüntetésére vonatkozó beállítások, a nagyítás és a 
különböző színes/szürkeállományos megjelenítés. 
 
9. kép 
A Nézet menüszalag 
 
 
 
 

 
 



 15

A PowerPoint különféle nézeteinek használata fontos szerepet játszik bemutatóink 
elkészítésében és bemutatásában, valamint a munkafolyamatok leegyszerűsíthetőek a 
megfelelő nézet kiválasztásával. 

 
Normál (Normal) nézet  

 
A Normál nézet, amelybe a Normál (Normal) nézetválasztó gomb vagy a Nézet 

szalag Normál parancsával (View > Normal) válthatunk át. Ez a nézet három ablaktáblát 
tartalmaz: a Vázlat, a Dia és a Jegyzet ablaktáblákat. Az előadás elkészítése ebben a 
nézetben a legegyszerűbb, mert egyetlen képernyőn áttekinthetjük az anyag 
elkészítéséhez szükséges információkat. A bal oldali, Vázlat (Outline) ablaktáblán a 
bemutató szövege látható, képek nélkül. Így könnyen áttekinthetjük a bemutató 
szerkezetét, és egyszerűbben elvégezhetjük a szöveges változtatásokat. A Vázlat 
ablaktáblát a felül látható Diák (Slides) fülre kattintva átalakíthatjuk úgy, hogy a bal 
oldalon az előadások kicsinyített diaképei jelenjenek meg. Az alsó, Jegyzet (Notes)  
ablaktáblán az aktuális képkockához kapcsolódó megjegyzéseinket írhatjuk le. Az 
ablaktáblák méretét a szegélyek húzásával tetszőlegesen megváltoztathatjuk. 
 
Diarendező nézet  
 

Diarendező nézetre a Diarendező (Slide Sorter) nézetválasztó gomb vagy a 
Nézet szalag Diarendező parancsa segítségével válthatunk át (View > Slide Sorter). A 
Diarendező nézetben, a diák nagyításától függően, az előadás összes képkockája 
egyszerre látható. Ebben a nézetben a diák tudjuk a leghatékonyabban szerkeszteni (dia 
vagy diatartományok másolása, törlése, áthelyezése). 
 
Diavetítés nézet  
 

A Diavetítés (Slide Show) nézetet az előadás ellenőrzésekor vagy a 
bemutatásakor használjuk. Ebben a nézetben a képkockák a teljes képernyőt kitöltő 
méretben jelennek meg (a menüszalagok nélkül). Legegyszerűbben azonban az F5 
gombbal tudunk erre a nézetre váltani. A nézetválasztó gombbal az aktuális diától 
indítjuk a vetítést (Shift + F5), a Diavetítés paranccsal pedig az első képkockától indul a 
vetítés (F5). 
 

Diák elrendezése 
 

A dia tartalmától függően különböző elrendezésekben tudjuk a szöveget 
feltüntetni. Ez opció a Kezdőlap szalagon az Elrendezés legördülő menüben található 
(Home > Layout). Ez a beállítás elérhető a Dia ablaktáblán, a jobb gombbal 
megjelenített helyi menüben. 
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10. kép 
A dia elrendezésének lehetőségei 

 

 
 
 

Néhány esetben a tartalom részben gyorsindítók jelennek meg, amelyekre 
klikkelve az adott objektumot tudjuk beszúrni. Ezek: Táblázat beszúrása, Diagram 
beillesztése, SmartArt-ábra beszúrása, Kép beszúrása fájlból, ClipArt és Médiaklip 
beszúrása.   
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11. kép 
Cím és tartalom elrendezés a gyorsindítókkal 
 

 
 
Új dia létrehozása  
 

Új dia létrehozásához használjuk a Kezdőlap szalag Új dia ikonját (Home > New 
Slide), amely legördülő menüjéből kiválasztható a dia elrendezése emellett CTRL+M 
billentyűkombinációt. Az új dia mindig az aktuális dia után szúródik be, és azonnal 
felveszi az előadás alapjául szolgáló sablon formátumait. A PowerPoint a választott 
elrendezéstől függően létrehozza a helyőrzőket a dia egyes elemei (pl. szövegek, képek, 
táblázatok) számára. Szöveg begépeléséhez kattintsunk egyet a szöveges helyőrzők 
területére. 
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12. kép 
Új dia beszúrása 
 

 
 
 

Dia törlése 
 

A dia törlése a Dia ablaktáblában a jobb egérgombbal megjelenített helyi menü 
Dia törlése (Delet Slide) parancsával vagy a kijelölése után a Delete nyomógomb 
lenyomásával lehetséges.  
 
Dia áthelyezése és másolása 
 

A dia (vagy diák) áthelyezése a Dia ablaktáblán vagy a Diarendező nézetben 
lehetséges a diák áthúzásával vagy a Kivágás és Beillesztés művelettel (a dia helyi 
menüjéből). A másolás a hagyományos Másolás-Beillesztés művelettel történik. Egy dia 
teljes tartalmának másolatát (a következő diára) a helyi menüből (a Dia ablaktáblán) 
kiválasztott Diamásolat (Duplicate Slide) menüpont segítségével tudjuk beilleszteni a 
prezentációnkba. 
 
Dia elrejtése 
 

Ha egy diát vagy diatartományt nem szeretnénk a vetítés során bemutatni, de 
törölni sem szeretnénk, akkor a kijelölés után a Dia ablaktáblán a  helyi menüben a Dia 
elrejtése (Hide Slide) opcióval tudjuk a diát (diákat) rejtetté tenni. A rejtett diák nem 
kerülnek vetítésre és a sorszámuk áthúzottá vál. A diák elrejtésének feloldása ugyanezen 
a módon történik. 
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13. kép 
Diák elrejtésének feloldása a helyi menüből (a dia sorszáma áthúzott, tehát rejtett) 

 

 
 
 
FELADATOK 
 
1. Hozzunk létre egy prezentációt, amely 5 diából áll. Az első dia legyen Címdia (Title 
Slide), a második, harmadik és negyedik Cím és tartalom (Title and Content) az ötödik 
pedig Üres (Blank). Vagyünk fel tetszőleges szövegeket a diák helyőrzőibe (például: 2. 
dia címe, 2. dia tartalma). Az ötödik diát helyezzük át az első helyre. A harmadik diát 
tegyük rejtetté, az utolsót pedig töröljük le. 
2. Próbáljuk ki mentési lehetőségeket (ppt, pptx, pps, ppsx, jpeg, pdf, rtf). Figyeljük meg 
a fájlok közötti különbségeket. 
 

A prezentáció grafikai elemei 
 
Bemutató létrehozása beépített témák alapján 
 
 A PowerPointban lehetőségünk nyílik nagyszámú előre elkészített sablon 
használatára. A helyőrzőkbe létrehozott tartalmat grafikai elemekkel (elrendezés, háttér, 
karakterformázás, színek) legegyszerűbben a beépített sablonok alkalmazásával tudjuk 
látványosabbá tenni. A beépített sablonokat a Tervezés (Design) szalag Témák 
(Themes) részébe tudjuk megjeleníteni. 
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14. kép 
Beépített sablonok a PowerPoint 2010-es szoftverben 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
Az oldal beállítását is itt tudjuk módosítani (álló, fekvő, diák mérete), valamint az 

elfogadott témákat is itt tudjuk módosítani a Színek (Colors) és a Háttérstílusok 
(Background Styles) legördülő menük segítségével. 
 
Egyedi témák alkalmazása 
 

Ha eredeti prezentációt szeretnénk elkészíteni (a beépített témákat gyakran 
használják az előadók), akkor ajánlott az egyedi témák alkalmazása. Ezeket a témákat az 
internetről tudjuk letölteni (ajánlott keresési kulcsszavak: free PowerPoint templates, 
beautiful powerpoint templates). Ezeket a pot vagy potx kiterjesztésű fájlokat tuduk 
alkalmazni egy, már meglévő bemutatónkra a Tervezés, Témák (legördülő menü 
lenyitásával) Témák keresése menüpontra klikkelve (Design > Browse for Themes). 
Ezután az elmentett téma elérési útvonalát kell meghatározni. 
 
Ingyenes sablonok gyűjteménye: 
 
http://blog.namesztovszkizsolt.com/wp-
content/uploads/2009/10/powerpoint/ppsablonok.htm 
 
Egyedi háttér alkalmazása 
 

Bár első látásra jelentéktelennek tűnhet, mégis igen fontos hangulati tényező a dia 
háttere. Lehetőségünk van a témák használata mellettni háttér elkészítésére. 

Egyedi hátteret a diára jobb klikkel történő klikkelés és a helyi menüből a Háttér 
formázása (Format Background) menüpont kiválasztásával tudunk engedélyezni. Ezen 
a panelen az opciót kiválasztva engedélyezzük az aktuális diára, a Mindegyik (Apply to 
All) gombbal pedig az összes diára. A Háttér grafikus elemeinek elrejtése (Hide 
background graphics) opció bekapcsolásával az alkalmazott téma elemeit tudjuk 
eltüntetni. 

http://blog.namesztovszkizsolt.com/wp
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15. kép 
A Háttér grafikus elemeinek elrejtése funkció hatása 
 

 
 
 A legegyszerűbb egyedi háttér az Egyszínű kitöltés (Solid fill), amelyhez a színt 
a legördülő menüből tudjuk kiválasztani. 
 
16. kép 
Egyszínű kitöltés alkalmazása egyedi háttérként 
 

 
 

A További színek (More Colors) Egyéni (Custom) ablakában lehetőségünk 
egyéni színek „kikeverésére” vagy leolvasására az RGB (Red, Green, Blue) vagy a HSL 
(Hue, Sat, Lum) színskálák segítségével. A leggyakrabban használt színskála az 
úgynevezett RGB skála. A skála lényege az, hogy a vörös, a zöld és a kék szín arányát 
határozza meg egy 255-ig terjedő skálán. Segítségével több mint 16 millió szín (255* 
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255*255) kikeverésére nyílik lehetőségünk. A skála segítségével tudunk legegyszerűbben 
behozni egy színárnyalatot egy másik programból (az adatok átmásolásával). Az egyéni 
színeket  felvenni a különbüző objektumok színezésénél, szövegdobozok hátterénél, 
WordArtok színezésénél, stb. A másik skála a HSL (Hue, Sat, Lum), amelynél az 
Árnyalat, a Telítettség és a Fényesség segítségévle tudjuk definiálni a színeket (szintén 
255-ös skálán). 

 
17. kép 
Egyéni szín alkalmazása az RGB skála segítségével 

 

 
 

Színátmenet (Gradient fill) alkalmazása kettő vagy több színátmeneti végpont 
hozzáadásával definiálásával lehetséges. A végpontok beállítása mellett meghatározható 
ezek helyzete a színátmenet iránya és típusa is. 
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18. kép 
Színátmenet alkalmazása 
 

 
 

 
 

Kitöltés képpel vagy anyagmintával (Picture or texture fill) lehetőségként a 
felkínált anyagminták vagy a háttértárunkon vagy a Vágólapon (Clipboard) tárolt képet 
tudjuk háttérképként alkalmazni. A képet a Beszúrás forrása (Insert from) felirat alatt 
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található Fájl (File) gombra klikkelve tudjuk beszúrni. Az alkalmazott hátérkép 
módosítható: eltolható, módosítható az átlátszósága (transparancy), fényereje, lágysága, 
színe a Képkorekció, Kép színe és a Művészi effektusok menüpontok segítségével (2010-
es verzióban). Az alkalmazott háttérkép színe és fényereje a jó olvashatóságát és a 
prezentáció kellemes hangulatát kell hogy eredményezze. 
 
19. kép 
Kitöltés képpel vagy anyagmintával 

 

 
 

A Kitöltés mintával (Pattern Fill) opcióval lehetőségünk van egyszerűbb mintát 
engedélyezni háttérként. A minta mellett meghatározható az Előtérszín (Foreground 
Color) és a Háttérszín is (Background Color). 
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20. kép 
Kitöltés mintával 

 

 
 

 
FELADATOK 
 
1. Nyissuk meg a szin.ppt prezentációt, majd háttérként alkalmazzunk a R:200, G: 200, 
B: 200 színt. Ellenőrizzük, hogy a felvett szín megegyezik a táblázat háttérszínével 
2. Hozzunk létre sugaras színátmenetet 6 végpont segítségével a kék különböző 
árnyalataival. 
3. Alkalmazzunk egy tetszőleges sötétebb színárnyalatú háttérképet. A beállítások 
(átlátszóság, fényerő vagy egyéb effektusok) módosításával érjük el azt, hogy a szöveg 
jól olvasható legyen.  
4. Egy meglévő prezentációra alkalmazzunk egy témát, amelyet a következő címről 
töltünk le: http://blog.namesztovszkizsolt.com/wp-
content/uploads/2009/10/powerpoint/ppsablonok.htm 
5. Készítsünk egy olyan bemutatót, amelynek első oldalának a háttere sablon, a második 
oldal háttere egyéni szín (R: 255, G:1, B:1), a harmadik oldal háttere színátmenet, a 
negyedik oldal háttere anyagminta, az ötödik oldal háttere mintázat, a hatodiké pedig kép 
(minta: hatter.ppt) 
 
 
 
 
 
 

http://blog.namesztovszkizsolt.com/wp
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Szövegdobozok  
 

A bemutatónkra szánt szöveget a Szövegdobozokba (Text Box) tudjuk begépelni. 
Szövegdobozok létrejönnek a diákra alkalmazott elrendezés alkalmával, de létre is 
hozhatóak a Beszúrás szalag Szövegdoboz parancsával (Insert > Text Box). A parancs 
kiválasztása után meg kell határozni a szövegdoboz helyét és méretét (bal klikkel és az 
egér húzásával). Az elkészített szövegdobozok, más grafikai objektumokhoz hasonlóan, 
másolhatóak, törölhetőek és kivághatóak. 

A létrehozott szövegdobozt a körvonalára klikkelve tudjuk kijelölni. Ezután 
átméretezhető  a sarkokban található fehér köröcskék, vagy az oldalfelezőknél található 
négyzet segítségével (bal klikkel kell ráklikkelni és áthúzni egérrel). A szövegdoboz 
felett található zöld köröcske segítségévél elforgatható a szövegdoboz. 

 
21. kép 
Egy kijelölt szövegdoboz és a szerkesztéshez szükséges köröcskék és négyzetek 

 
A szövegdobozok szerkesztésére szolgáló összes lehetőség a Formátum 

(Format) menüszalagon található, amely a szövegdoboz kijelölése után válik elérhetővé, 
illetve a szövegdoboz körvonalára történő dupla klikkelés után. 

 
22. kép 
A szövegdobozok szerkesztését tartalmazó Formátum menüszalag 

 
 
 
 
 
 

 
 A Formátum menüszalag Alakzatstílusok (Shape Styles) sablonjai közül ki 
tudunk választani előre definiált sablonokat. A Kitöltés (Shape Fill) legördülő menüből a 
szövegdoboz kitöltőszínét (kitöltőképét, színátmenetét vagy anyagmintáját) tudjuk 
meghatározni. 
 A Körvonal (Shape Outline) legördülő menüből a szövegdoboz körvonalának 
színét, vonalvastagságát és stílusát tudjuk meghatározni. 
 Az Effektusok (Shape Effects) menüből a szövegdobozra vonatkozó hatásokat 
tudjuk engedélyezni leggyakrabban a Árnyék (Shadow), a Tükröződés (Reflection) és a 
Ragyogás (Glow) hatást használjuk. Az alkalmazott effektusok a többi színnel 
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összhangban kell hogy legyenek, és nem szabad hogy a közérthetőséget valamint az 
olvashatóságot csökkentsék. 
 A WordArt-stílusok (WordArt Styles) rész a szövegdobozok szövegére 
alkalmazható módosításokat tartalmazzák. Előre elkészített témák közül választhatunk 
WordArt (WordArt) mezőből.  

A Szöveg kitöltése (TextFill) legördülő menüjéből a szöveg kitöltőszínét, a 
szöveget kitöltő képet, színátmenetet vagy anyagmintáját tudjuk meghatározni. 

A Szöveg körvonala (Text Outline) legördülő menüből a szöveg körvonalának 
színét, vonalvastagságát és stílusát tudjuk meghatározni. 
 Az Effektusok a szövegben (Text Effects) legördülő menüből a szövegre tudunk 
különböző hatásokat engedélyezni, amelyek nagyban hasonlítanak a szövegdoboz 
háterrére alkalmazható hatásokhoz. A szöveg esetében az Átalakítás (Transform) 
hatással tudunk látványos hatást elérni (hajlítás, görbekövető hatások).  
 A menüszalagon lehetséges még a szövegdobozok Igazítása (Align), Forgatásuk 
(Rotate), valamint a magasságuk és a szélességük pontos meghatározása. 

A Felsorolás (Bullets) és a Számozás (Numbering) funkciók a hasonlóak mint a 
Word szoftverben tapasztaltuk (a Kezdőlap szalagon taláható), de lehetőségünk van a 
felsorolás jel színének a módosítására, valamint a szöveghez viszonyított méretének a 
módosítására (százalékban meghatározva). Ezen kívül a Kép (Picture) gomb 
segítségével külső képeket (vagy a Clipartok közül választva) tudunk meghatározni 
felsorolást jelző grafikus listajelet. 
 
23. kép 
A felsorolások beállításai 
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FELADATOK 
 
1. Hozzunk létre négy különböző szövedobozt 3-as vastagságú, pontozott szürke 
körvonallal. Az első szövegdoboz háttere legyen színátmenetes, a másodiké anyagmintás, 
a harmadiké mintázat, a negyediké pedig 50 százalékban átlátszó (minta: 
szovegdobozok1.ppt ) 
2. Hozzunk létre egy prezentációt, amelynek háttere és a rajta található szövegdobozok 
kék színűek. Módosítsuk a szövegdobozokban a felsorolásjeleket úgy hogy 
illeszkedjenek a kék színhez, valamint legyen 120%-os méretű (minta: 
szovegdobozok2.ppt ) 
3. Hozzunk létre a háttérszínhez illeszkedő szövegdobozokat (négy darabot). Az első 
szövegdobozra alkalmazzunk ragyogást (szintén a háttérhez illeszkedő színben), a 
másodikra tükröződést, a harmadikra pedig árnyékot, a negyedik szövegdobozban pedig a 
szövegre engedélyezzünk tükröződést 
(minta: szovegdobozok3.ppt ) 
 

WordArt 
 

A WordArt díszes szöveg, amely cím vagy más fontos szövegrész 
kihangsúlyozására használunk. Létrehozása a Beszúrás (Insert) menüszalagról történik a 
WordArt legördülő menüben a megfelelő színű, hatású WordArt kiválasztásával.  

 
24. kép 
A WordArtok kiválasztása 
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A WordArtok módosítása Formátum (Format) menüszalagon történik, amely 
megegyezik a szövegdobozok szerkesztésénél megjelenő menüszalaggal (a szalag 
kijelöléssel vagy a WordArt körvonalára duplán klikkelve jeleníthető meg). Ezen a részen 
a WordArt szerkeszthető (kitöltőszín, körvonal, különböző effektusok), meghatározható a 
mérete, valamint elforgatható. Ezen a részen találjuk az Igazítás (Align), amellyel a 
WordArtot tudjuk a dia megfelelő részére igazítani. Ez az opció jelen van a 
szövegdobozoknál, a különböző alagzatoknál és a diagramoknál is. 
 
25. kép 
Az igazítás menüpont 

 

 
 
 
FELADATOK 
 
1. Hozzunk létre egy WordArtot, amelynek felszínét anyagminta tölti ki és 3-as 
vastagságú szaggatatott vonalak határolják. Használjuk egy szín árnyalatait, átalakítást 
(görbekövető) és ragyogás effektust. A létrehozott WordArtot igazítsuk vízszintesen a dia 
közepére (minta: wordart.ppt ). 
 

Alakzatok (Shapes) 
 

A különböző alakzatok beszúrására a Beszúrás menüszalag, Alakzatok 
menüpontjával van lehetőségünk (Insert > Shapes). Az alakzatok csoportokba vannak 
rendezve (legutóbb használt, vonalak, egyszerű alagzatok, nyilak, stb.). Az alakzatok 
helyét és méretét az egér húzásával (jobb klikk tartása mellett) tudjuk meghatározni. A 
létrehozott alakzatok szerkesztése dupla klikkelés után lehetséges (a szerkesztés nagyban 
megegyezik a szövegdobozok szerkesztésével). Szabályos alakzatok (kör, négyzet, 
csillag, stb.) rajzolása a Shift gomb tartása mellett vagy az alakzat kiválasztása után dupla 
klikkeléssel lehetséges. Az alakzatok egy részébe (nyilak, szövegfelhők, egyszerűbb 
alagzatok) lehetséges a szöveg felvétele is. Ez a folyamat az objektum kijelölése után 
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egyszerű begépeléssel történik (az alakzaton nem jelenik meg a szövegbevitelt jelző 
kurzor). 

 
26. kép 
Alakzatok beszúrása 

 

 
 

FELADATOK 
 
1. Szúrjunk be egy napot, egy holdat, egy felhőt, egy villámot és egy smiley jelet. 
Rendezzük az alagzatokat és színezzük át. Helyezzünk egy tilos táblát a villámra. 
2. Szúrjunk be egy nyilat és egy szövegfelhőt. Színezzük az alagzatokat és vegyünk fel 
rájuk szöveget (forgassuk el a nyilat úgy hogy a felhőre mutasson). 

 
SmartArt-ábra (SmartArt Graphic)  

 
Különböző ábrák felvételével látványosabb bemutatót tudunk létrehozni, valamint 

az általunk szerkesztett elemek teljes mértékben illeszkednek az elképzeléseinkhez, 
valamint a későbbiekben szerkeszthetők is. Ezeket az ábrákat a PowerPointban 
SmartArt-ábrának (SmartArt Graphic) nevezzük.  Beszúrásuk az Beszúrás menü 
SmartArt menüpontjával lehetséges (Insert > SmartArt).  
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27. kép 
SmartArt-ábrák csoportjai 

 

 
 

 
A kiválasztott és beszúrt ábrát szerkeszteni szerkeszteni tudjuk közvetlenül az 

alagzatokon, valamint a szöveges részen. A szöveges részen Enter gomb lenyomásával 
tudunk új szintet felvenni, Tabulátor gombbal pedig alacsonyabb rendű tagot (például 
Szervezeti diagramnál). Az egyes alagzatok átszínezhetők, valamint a betűk mérete és 
típusas is módosíthatő a Kezdőlap menüszalagon. 

 
28. kép 
SmartArt-ábrák szerkesztése 
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Az ábra körvanalára klikkelve dupla klikkeléssel az ábra Tervezés menüszalagát 

tudjuk elérni, amelyen lehetőségünk van az ábra kinézetének a módosítására. Az 
Elrendezések (Layouts)  részen az ábrát alkotó szövegdobozok helyzet és alakja 
módosítható. A Más színek (Change Colors) legördülő menüben színssablonok 
segítségével átszínezhető a teljes ábra. A SmartArt-stílusok (SmartArt Styles) menü 
legördülő menüjéből az ábrák stílusa cserélhető. 

 
29. kép 
SmartArt-ábrák Tervezés menüje 

 
 
 
 
 

 
 

Egyes ábráknál lehetőségünk van képek beszúrására. Ilyen például a Függőleges 
képes lista (Vertical Picture List), amely esetében a kép ikonjára klikkelve tudunk 
képet beszúrni (a háttértárról megkeresve) . 

A SmartArt-ábrák külön csoportját képezik a Hierarchia (Hierarchy) 
elrendezésüek, amelyek közül a Szervezeti diagram (Organization Chart) a 
leggyakrabban használatos. A Szervezeti diagram szerkesztése megegyezik a fenn 
ismertetett alagzatok szerkesztésével. A szintek és alakzatok meghatározása a Tabulátor 
és az Enter lenyomásával a szöveges részen vagy a helyi menüből az Alakzat 
Hozzáadása (Add Shape) történik. 

Ha régebbi fájltípus (ppt) diagramjait vagy ábráit szeretnénk szerkeszteni, akkor 
ezeket először át kell alakítani (konvertálni). Ez a folyamat dupla klikkeléssel érhető el. 

 
FELADATOK 
 
1. Készítsünk egy Piramis (Pyramid) ábrát egy táplálkozási diagramról (pl.: növények, 
növényevők, ragadozók – konkrét elnevezésekkel). A piramis legalsó szintjét zöldre, a 
legmagasabbat pedig pirsora színezzük. 
2. Szúrjunk be egy Egyszerű ciklust (Basic Cycle), az alakzatokba írjuk be a víz 
körforgásának lépéseit (víz, pára, felhő, csapadék) és színezzük tetszés szerint. Az ábra 
középpontjába helyezzünk egy citromságra napot, narancssárga körvonallal. 
3. Hozzunk létre egy új bemutatót. Első diáját rendezzük cím és tartalom téma szerint. 
Címként írjuk be a következő szöveget: „Cégünk a következő termékeket forgalmazza:”. 
A tartalom részben hozzunk létre (az ikonra klikkelve) egy képes listát, amelybe a 
következő feliratok kerülnek: PC, DVD lejátszó, Házimozi, GPS. A listát illusztráljuk 
képekkel a KepesLista mappából vagy az internetről. Engedélyezzünk Intenzív (Intense) 
effektust az ábrának, valamint az első tagnap piros kitöltőszínt és ragyogást. Mentsük el 
bemutatót SmartArt.pptx név alatt. 
4. Készítsünk egy tetszőleges szervezeti diagramot egy iskola felépítéséről (iskolaszék, 
igazgató, titkár, titkárnő, igazgatóhelyettes, tanárok, diákok, takarító, fűtő, stb.) 
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Diagram (Chart)  
 

 Diagram átmásálása Excelből vagy akár a Word szoftverből is lehetséges, de a 
PowerPointban is lehetőségünk van diagramot létrehozni az első lépésektől indulva. 
Diagramot a Beszúrás menüszalag Diagram parancsával tudunk létrehozni (Insert > 
Chart).  

Első lépésként a diagram típusát kell meghatározni (oszlop, vonal, kör, stb.). 
Ezután a diagram adatait a képernyő másik oldalán található Excel szerkesztőfelületen 
kell meghatározni a felkínált szöveg és adatok cseréjével, valamint az adattartomány 
módosításával. 
 
30. kép 
A diagram adatainak meghatározása az Excel munkaablak segítségével 
 

 
 
 

A létrehozott diagram szerkeszthető (kijelölés vagy dupla klikkelés után) a 
Diagrameszközök (Chart Tools) Tervezés (Design) menüszallagán található 
eszközökkel.  

 
31. kép 
A Diagrameszközök Tervezés szalag 
 
 
 
 
 
 
 

 
A Diagramstílusok (Chart Styles) legördülő menüjéből különböző színekből 

álló stílusokat tudunk a diagramra alkalmazni (a diagram részeinek valamint a háttér 
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kitöltőszínét tudjuk módosítani). Az egyes részek (tortaszeletek és oszlopok) szintén 
átszínezhetőek, kijelölésük után (kijelölés két klikkeléssel: első klikkelés – sorozat 
kijelölése, második klikkelés – aktuális rész kijelölése). A Kezdőlap menüszalag 
Kitöltés  parancsával (Home > Shape Fill). A diagram háttereként szolgáló Rajzterület 
(Plot Area) és a Diagramterület (Chart Area) is ugyanezen a módon színezhető át. A 
vonaldiagramon taláható vonal valamint a rácsvonalak a Kezdőlap menüszalagon 
található Körvonal  paranccsal színezhető át (Home > Shape Outline). 
 A Tervezés menüszalagon található Diagramelrendezések (Chart Layouts) 
legördülő menüje segítségével a létrehozott diagram módosítható, átalakítható (a diagram 
címe, a tengelyek megnevezései, számok, százalékos arányok jeleníthatő meg).  
 Az Adatok szerkesztése (Edit Data) funkcióval újra megnyitjuk az Excel 
munkalapot és lehetővé válik az adatok szerkesztése. A Sor/oszlop váltása (Switch 
Row/Column) opcióval a sorok és az oszlopok helyét és helyzetét tudjuk cserélni az 
aktuális diagramon. A Más diagramtípus (Change chart Type) paranccsal az aktuális 
diagram típusát tudjuk cserélni az első lépésben megjelent diagramtípus-választó ablak 
segítségével. 
 
FELADATOK 
 
1. Hozzunk létre egy olyan oszlopdiagramot, amelyen egy számítógépes cég múlt évi 
forgalmát tüntetjük fel a következő adatokkal: PC-k: 3200, DVD lejátszók: 2400, 
Házimozi: 1200, GPS eszközök: 1600. Töröljük le a kategória megnevezését. A 
diagramstílusok közül válasszunk olyan stílust, amely fekete diagramterületet és szürke 
rajzterületet tartalmaz, kék színű oszlopokkal. Színezzük át PC-k eladását ábrázoló 
oszlopot pirosra, valamint engedélyezzünk szürke hátteret a diára. Igazítsuk a diagramot 
vízszintesen és függőlegesen is közlore. Másoljuk az aktuális dia elé a SmartArt.pptx 
prezentáció diáját. Mentsük el diagram.ppt név alatt.  
2. Alakítsuk át a létrehozott diagramot kördiagrammá, amelyen láthatóak lesznek a 
megnevezések és a százalékok is. 
 

A Clipart 
 

Előadásainkat színesebbé tehetjük különféle rajzok, képek, hangok és videók 
használatával. A PowerPointhoz, illetve az Office programokhoz mellékelt képeket, 
mozgóképeket és hangokat a ClipArt (Clip Art) tartalmazza, amelyet a régebbi 
verziókban Médiatárnak neveztek. 

Ez az opció a Beszúrás menüszalag ClipArt ikonjával érhető el (Insert > 
SClipArt). Ezután a jobb oldali munkaablakban jelenik meg a ClipArtok keresésére 
szolgáló mező. A Keresett szöveg (Search for) mezőbe kell beírni a keresés kulcsszavát 
(a telepített szoftver nyelvével összhangban). Az Eredmény (Results should be) 
legördülő menüben meg tudjuk határozni a találatok típusát a következő lehetőségek 
közül: Ábrák (Clip Art), Fényképek (Photographs), Videofájlok (Movies), 
Hangfájlok (Sounds). Az Office.com-tartalommal együtt (Include Office.com 
content) jelölőnégyzet engedélyezésével jóváhagyjuk a tartalmak keresését az Office 
internetes adatbázisában is. A megjelent találatokat egy bal klikkel vagy áthúzással 
tudjuk a dia felületérs mozgatni (a mozgóképek csak Diavetítés módban animálódnak). 
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32. kép 
A ClipArt munkaablak 

 
 

 
 

 
 

FELADATOK 
 
1. Keressünk iskolával (school) kapcsolatos ábrákat, majd másoljuk a dia felületére. 
2. Keressünk iskolával (school) kapcsolatos fényképeket, majd másoljuk a dia felületére. 
3. Keressünk számítógéppel (computer) kapcsolatos videofájlot, majd másoljuk a dia 
felületére. 
4. Keressünk zene (music) kulcsszóra hangfájlot, majd másoljuk a dia felületére. 

 
Képek beszúrása fájlból 

 
Egyéni képeket a számítógépünk háttértáráról tudunk beszúrni, amelyeket 

előzőleg mi készítettünk vagy az internetről töltöttünk le. A kép beszúrása az Beszúrás 
menüszalag Kép menüpontjából kezdeményezhető (Insert > Picture). A beszúrt 
szerkesztése dupla klikkel (a kép felületére) nyitható meg. 

 
33. kép 
A kép szerkesztése a Formátum (Format) menüszalaggal 

 
 
 
 
 
 



 36

 
Ezen a menüszalagon lehetséges a kép módosítása, a háttért eltávolítása, a kép 

korrekciói, színének módosítása, valamint művészi effektusok hozzáadása. A 
Képstílusok (Picture Styles) legördülő menübe a képre alkalmazható beépített stílusok 
érhetők el. 

 
34. kép 
A Képstílusok legördülő menü felkínált szerkesztési lehetőségei 

 
 

 
 

 
 
 
 
A formátum menüszalag tartalmazza még a Képszegély (Picture Border) 

szerkesztésére vonatkozó ikont, valamint  a Képeffektusok (Picture Effects) utasítás, 
amely menüpontjai megegyeznek az egyéb objektumokra (szövegdoboz, alakzatok) 
engedélyezhető effektusokkal. 

A Formátum panel végén helyezkednek el a kép méretére vonatkozó szerkesztési 
lehetőségek Méret (Size) rész alatt, ahol lehetőségünk van a kép Körülvágására (Crop), 
amellyel a kép egyes részei távolíthatók el, illetve alakzatra vágható körül.  

 
35. kép 
A Méret panel műveletei  

 

 
 

A Körülvágás műveletet kiválasztása után a kép egyik sarkáról vagy 
oldalfelezőiből indulva, húzással (a kép közepe felé) határozzuk meg a levágásra kerülő 
rész határait, amelyet a képen a szürke tartomány jelöl. Az alakzatra vágás műveletével a 
legördülő menüből kiválasztott alakzat felületén lesz a kép látható. 
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36. kép 
A körülvágás és a körülvágás alakzatra parancsok eredményei 

     
 
A beszúrt objektum áthelyezéséhez a Fogd és vidd módszert használhatjuk. Az 

átméretezés az objektum kijelölése után a körülötte megjelenő méretezőjelek húzásával 
történhet. Az oldalak közepén elhelyezkedő jelekkel torzítva, míg a sarkoknál lévő 
jelekkel méretarányosan változtathatjuk meg a kép nagyságát. A zöld pontra klikkelve, és 
ezt lenyomva tartva, az egér mozgatásával forgatjuk el az objektumot. Az egérgomb 
elengedésével véglegesítjük a műveletet. 

 
37. kép 
A kép módosítására szolgáló méretezőjelek 
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38. kép 
A kép elforgatása 

 

 
 

FELADATOK 
 
1. Nyissuk meg a kepek.ppt.  
2. Az első dián állítsuk vissza eredeti helyzetbe az átszínezett nyilacskákat (piros szín).  
3. A második oldalon található képet forgassuk vissza eredeti állapotába, és vágjuk le a 
háttér fekete részét.  
4. Vágjuk felhő alakzatra a harmadik dián taláható képet, valamint engedélyezzünk a dia 
elemeihez illeszkedő ragyogó effektust. 
5. Távolítsuk el a fehér hátteret a negyedik képen található diáról. 
 

Objektumok fedése és csoportosítása 
 

Objektumok fedése 
 

Az objektumok (képek, rajzelemek, stb.) alapesetben úgy fogják egymást fedni, 
amilyen sorrendben azokat létrehoztuk. Ez a sorrend azonban megváltoztatható, ha a jobb 
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egérgombbal kattintunk az objektumon, majd a helyi menü Sorrend almenüjének kívánt 
pontját választjuk ki. A következő parancsok találhatóak meg itt: 

 Előrehozás (Bring to Front) utasítással az első helyre hozzuk előre az 
objektumot 

 Hátraküldés (Send to Back) utasítással az utolsó helyre küldjük hátra az 
objektumot 

 Előbbre hozás (Bring Forward) utasítással az objektumot egy fokozattal 
előbbre hozzuk 

 Hátrébb küldés (Send Backward) utasítással az objektumot egy fokozattal 
hátrább küldjük 
 
39. kép 
Az előrehozás (fekete kör) és az előbbre hozás parancs (piros kör) parancsok bemutatása 

 
 
 

       
 

Objektumok csoportosítása 
 

Önálló objektumok csoportosításakor a program azokat egy egységbe foglalja, így 
egyszerűbb lesz az objektumok átméretezése, mozgatása, színezése, mivel a parancs a 
csoport minden elemére érvényes lesz és nem kell azt egyesével elvégezni.  

Az objektumok csoportosításához jelöljük ki azokat úgy, hogy a Ctrl billentyű 
lenyomva tartása mellett kattintunk az egyes elemekre. Ezután kattintsunk a jobb 
gombbal, mutassunk a Csoportosítás pontra, majd kattintsunk a Csoportba foglalás 
(Grouping > Group) parancsra. A csoport alkotóelemeire bontása ugyanez az almenü, 
Csoportbontás (Ungroup) utasításával történik. 
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40. kép 
A csoportosítás előtti és utáni kép 
 

      
 

FELADATOK 
 
1. Hozzunk létre több hasonló objektumból álló alakzatot (virágminta, jégkrém). Ezután 
próbáljuk ki az előrehozás és a hátraküldés, valamint az előbbre hozás és a hátrébb küldés 
parancsokat 
2. Hozzunk létre egy szőlőfürt alakzatot, amelyet szabályos körök alkotnak. Foglaljuk 
egy csoportba az alakzatokat. Ezután alkalmazzunk egy műveletet a csoportra (színezés, 
átméretezés). Bontsuk elemeire a csoportot 

 
Vetítési beállítások 

 
A diavetítés beállításait a Diavetítés menü Diavetítés beállítása parancsával 

megjeleníthető párbeszéd panelen adjuk meg (Slide Show > Set Up Slide Show). Ez a 
párbeszéd panel jelenik meg akkor is, ha a SHIFT billentyű nyomva tartása közben 
kattintunk a Diavetítés nézetválasztó gombra. 

A Bemutató típusa (Show type) csoportban három különböző vetítési mód közül 
választhatunk.  

Alapesetben a Bemutatás élőszó mellett (teljes képernyő) (Presented by a 
speaker full screen) opciót használjuk, mely teljes képernyős vetítést tesz lehetővé az 
általunk megadott időzítésnek megfelelő lejátszással. A leggyakrabban használt vetítési 
mód, egy előadó irányítása mellett. Ezt a módszert használjuk ha a bemutatót nagyobb 
képernyőn szeretnénk kivetíteni, előadások, konferenciák alkalmával. 

Az Irányított bemutató (ablak) (Browsed by an individual window) opció 
választása esetén a bemutató egy ablakban kerül lejátszásra, melyhez külön eszköztár és 
menüsor tartozik (diák másolása, szerkesztése, nyomtatása). Ezt az opciót előadó nélküli 
bemutató vetítésére használhatjuk. Az előadás közönsége maga vezérelheti a bemutatót. 
Ezt a módszert akkor használjuk, ha a bemutatónkat kisebb képernyőn futtatjuk 
(hálózaton, felhasználók saját képernyőjükön tekintik meg a felhasználók). A gördítősáv 
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segítségével tudunk haladni diáról-diára, és egyidejűleg másik programot is nyitva 
tarthatunk. 

A Kirakati bemutató (Browsed at a kiosk) opcióval a bemutató egy önállóan 
futó, állandóan ismétlődő bemutatóként kerül lejátszásra. Akkor célszerű használni, ha a 
számítógépet egy kirakatban vagy elárúsítóhelyen felügyelet nélkül hagyjuk. Emellett ez 
az opció használatos iskolai bemutatók vetítésénél, amelyen az intézmény adatait, 
rendezvényeket vagy akár fényképeket mutatunk be. 

Az Egyéb beállítások (Show options) részen a folyamatos ismétlést tuduk 
engedélyezni (a kirakati bemutatónál alapértelmezett és nem módosítható), a 
kísérőszöveget és az animációt tudjuk kikapcsolni. Az egyéb beállítások részen 
határozható meg a Tintaszín (Pen color), valamint a Lézermutató színe (Laser pointer 
color). A digitális tinta (toll) a diavetítés nézetben a bal alsó sarokban található menüből 
vagy a CTR + P billentyűkonbinációval érhető el. A diavetítésre rajzolt elemek 
megőrzésére lehetőség van a vetítés befejezése után. 
 
41. kép 
A rajzolt elemek mentésére vonatkozó kérdés 

 

 
 
A digitális lézermutató a diavetítés nézetben a CTR lenyomásával „kapcsolható 

be”. 
A Diák (Show slides) csoportban meghatározhatjuk, mely képkockák kerüljenek 

lejátszásra. Ezt a részt akkor használhatjuk, ha a prezentáció egy részét szeretnénk csak 
bemutatni. Be tudjuk állítani az első (From) és az utolsó (To) kivetítésre kerülő diát. A 
Minden kocka (All) beállításnál az összes dia bemutatásra kerül. 

A Továbbítás (Advance slides) csoportban beállíthatjuk, hogy a képkockákat a 
vetítés során saját kezűleg továbítsuk (Manually) vagy az előre megadott időzítés alapján 
automatikusan játszódjanak le (Using timings, if present). 

A Vetítés több monitoron  (Multiple monitors) legördülő listában egy második 
monitor beállítására is lehetőségünkvan. Így az egyik monitoron az előadó az eladáshoz 
tartozó segítő információkat (a jegyzeteket, az előadás diáinak kicsinyített képét) láthat, 
míg a második monitoron teljes képernyőn vetíti a bemutatót. Ennek a lehetőségnek a 
használatához két monitor használatát lehetővé tevő hardverre van szükség (laptop 
képernyője + projektor). Ha ez a feltétel teljesül, akkor beállítható az elsődleges monitor, 
valamint megjeleníthető az előadi nézet is. 
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42. kép 
A vetítési beállításokat tartalmazó párbeszédablak 
 

 
 

 
FELADATOK 
 
1. Próbáljuk ki a három különböző vetítési módot, figyeljük meg a különbségeket a 
vetítés közben 
2. A tintaszín kiválasztása után rajzoljunk a diára vetítés közben 
3. Próbáljuk ki a lézermutatót úgy, hogy kék színűre váltjuk át 
4. Jelenítsük meg a hatter.ppt bemutató egy meghatározott részét (4-5 dia)  
 

Áttűnések beállítása 
 

Előadásunkat látványosabbá tehetjük a diákon megjelenő feliratok, képek 
animálásával, különféle áttűnési hatások beállításával. A megfelelően alkalmazott 
animációk vagy áttűnések nemcsak érdekesebbé tehetik előadásunkat, de segíthetnek 
mondandónk főbb részeinek kiemelésében is. Az áttűnésnek nevezzük a diaváltás során 
az egyik diaképből a másikba átvezető animációs hatást.  

Az áttűnésekre vonatkozó opciók az Áttűnés (Transition) menüszalagról érhetők 
el. Az Effektus beállításai (Effect Options) legördülő menüjéből a kiválasztott áttűnés 
módosítható (általában az animáció iránya módosítható). Ez a gomb mellett hangot 
tudunk rendelni az áttűnéshez, valamint az időtartamát tudjuk meghatározni. Ha beállított 
áttűnéseket az összes meglévő diára szeretnénk alkalmazni akkor a Mindegyikre (Apply 
To All) gombra kell klikkelnünk.  

A Továbbítás (Advance Slide) részen meghatározható az hogy a diák 
Kattintásra (On Mouse Click) vagy az Ennyi idő után (Automatically After) felirat 
mellé beírt időintervallum után kerüljenek továbbításra. 
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43. kép 
Áttűnések beállításai az Áttűnés menüszalagon 
 

 
 
 
 
 
 
 
FELADATOK 
 
1. Rendeljünk tetszőleges áttűnéseket  a hatter.ppt prezentáció diáihoz 
2. Rendeljünk automatikus továbbítást a diánkhoz (3 másodperc), valamint érjük el azt 
hogy a bemutatónk folyamatosan ismétlődjön (vetítési beállítások) 
 

Animálás 
 

Egy dián lévő szöveg (vagy alakzatok) alapesetben egyszerre jelennek meg. 
Gyakran azonban arra van szükségünk, hogy egyes elemek csak egymás után jelenjenek 
meg. Animációnak nevezzük a diák egyes elemeinek lejátszás során történő mozgatását, 
illetve fokozatos megjelenítését. A diáinkon szereplő elemeket nem csak áttűnéssel 
tudjuk megjeleníteni és eltüntetni, hanem az egyes elemekre egyéni animációt tudunk 
engedélyezni. Ajánlatos kipróbálni az animációkat, hiszen az egyszerű beúszástól, a 
gépírásos, a beeső, az elforduló, a fényképezőgépszerű megjelenítéseken át, a 
legkülönfélébb megjelenítésig sokféle animációt választhatunk. Az animációkat 
hanghatások is kísérhetik.  A PowerPoint messzemenően támogatja ezt a lehetőséget, 
hiszen nemcsak animálni tudjuk a diákon található objektumainkat, hanem időzíteni is. 
Az egyes elemek animálása jelentik a PowerPoint legnagyobb előnyét, mivel ezek 
segítségével elérhető a fokozatosság az előadásaink során. 

Az animációk létrehozása és módosítása az Animációk (Animation) 
menüszalagon lehetséges. A grafikus elemek és a szöveg animálása némileg eltér, ezért 
külön-külön az alcímben ismertetjük. 

 
44. kép 
Animációk menüszalag 
 
 

 
 
 
 
Az animációk csoportokba rendezve jelennek meg. Ezek: Megjelenés 

(Entrance), Kiemelés (Emphasis), Eltűnés (Exit)  és Mozgásvonalak (Motion Path). 
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45. kép 
Az animációk csoportosítása 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Grafikus elemek animálása 
 

Grafikus elemek csoportjába tartoznak a különböző alakzatok, képek, diagramok 
és SmartArtok. Ezen elemek animálását az objektum kijelölésével kell kezdeni. Ezután az 
Animáció (Animation) legördülő menüből vagy az Animáció hozzáadása (Add 
Animation) gombra klikkelve tudunk megfelelő animációt kiválasztani. Az 
engedélyezett animáció az Effektus beállításai (Effect Option) legördülő menüből 
módosítható. A módosítások általában az animáció irányára vonatkoznak.  

 
46. kép 
Az animációk további szerkesztése 

 

 
 
Az Animáció munkaablak (Animation Panel) részen az animációs hatások 

tekinthetők át. Itt lehetséges az animációk lejátszása és átrendezése is a Lejátszás (Play) 
és az Átrendezés (Re-Order) opciókkal. 
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47. kép 
Az Animáció munkaablak 

 

 
 
Az Animáció másolása (Animation Painter) a 2010-es szoftverben jelent meg 

először, de igen hasznosnak bizonyul és jelentősen meggyorsítja az animációk 
létrehozását. 

Az Indítás (Start) legördülő menüből tudjuk meghatározni azt hogy hogyan 
induljanak az animációink. A következő lehetőségek közül választhatunk: Kattintásra 
(On Click), Együtt az előzővel (With Previous) és Az előző után (After Previous). 
Emellett meghatározható az animáció időtartama és késleltetése is. Az animáció 
átrendezése az Időzítés panelen is lehetséges. 

 
FELADATOK 
 
1. Hozzunk létre egy szabályos négyzetet és egy kört. A négyzetet színezzük kékre, a kört 
pedig pirosra. Engedélyezzünk mindkét alakzatra Beúszás (Fly in) animációs hatást. 
Módosítsuk az animációk irányát és rendezzük át. 
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2. Módosítsuk az animációk indítását úgy hogy először kattintásra, majd az előzővel, 
legutoljára pedig az előző után induljonak. 
3. Engedélyezzünk az alakzatokra kiemelő és eltűnési effektust is. 
4. Egy újabb alakzaton próbáljuk ki a további mozgásvonalak animációt is. 
5. Nyissuk meg a diagram.ppt fájlot. Engedélyezzünk címet a prezentációra. Szúrjunk be 
egy elipszist (kitöltőszín nélkül) a PC-k oszlopra. Ezután engedélyezzünk Ék (Wedge) az 
elipszisre. 

 
Szöveg animálása 

 
A szöveg animálási hatásainak hozzáadása megegyezik az alakzatok 

animálásával. A diáinkon szereplő szöveg animációit viszont, a prezentációnk 
hatékonyságának növelése érdekében, viszont részletesebben is tudjuk definiálni. Ezen 
animációk módosítása az Animáció munkablakban az animáció mellett található lefelé 
mutató nyílra, majd a legördülő menüből az Effektus beállítása (Effect Options). 

 
48. kép 
Az Animáció munkaablak 

 

 
 
 
Az effektus beállításai munkaablakban az egyes animációkhoz hangot tudunk 

rendelni. Ezen kívül meghatározható a szöveg állapota az Animáció után (After 
animation). A szöveges animációk lejátszása után általában egy halványabb színárnyalat 
engedélyezése a megszokott. Ez a megoldás lehetővé teszi az előadásunk hatékonyabb 
követését, mivel látszik az aktuális szövegdoboz, de vissza is tudunk ismételni az előző 
bekezdésekhez. A munkaablakban az animáció utáni alapbeállítás a Nincs halványítás 
(Don`t Dim), de a színváltás mellett megoldható az is hogy az aktuális szöveg eltűnjön. 
Ez a művelet az Elrejtés animáció után (Hide after animation) vagy az Elrejtés a 
következő kattintásra (Hide on next mouse Click) opciók kiválasztásával lehetséges. 
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49. kép 
Az Animáció után legördülő menü elemei 
 

 
 

Egy szövegre engedélyezett animáció megjelenítése különböző formában 
lehetséges a Szöveg animálása (Animate text) résznél a következő elemek közül lehet 
választani: All at once (Egyszerre) Szavanként (By word) és Betűnként (By letter). 

 
50. kép 
Szöveg animálása lehetőségei 
 

 
 

Az Időzítés (Timing) fülnél meghatározhatjuk az elem megjelenésének olyan 
időzítési paramétereit, mint az Indítás  (Start) módját, a Késleltetés (Delay), valamint 
módosítható az Időtartam (Speed) és az Ismétlés (Repeat) módja. Ezen kívül indítók 
rendelhetők az animációkhoz, valamint a Lejátszás után az elejére opció is módosítható.  
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51. kép 
Az időzítés fül elemei 

 

 
 
Ha olyan szövegdobozokat hozunk létre, amelyeknél a háttér is engedélyezett, 

akkor a szöveg és a háttéralakzat animációja szétválasztható a Szöveg animálása (Text 
Animation) fül alatt a Csatolt alakzat animálása (Animate atached shape) 
jelölőnégyzet kikapcsolásával. 

 
52. kép 
Szöveg animálása fül kinézete 

 

 
 

Az animáció törlése az animáció munkaablakban, az animáció kijelölése után, a 
helyi menüben található Eltávolítás (Remove) vagy a Delete nyomógomb lenyomásával 
történik. 
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FELADATOK 
 
1. Hozzunk létre egy szövegdobozt, amelybe fekete szöveggel a következő szöveg kerül: 
„Animáció próba 1 szöveggel”. Engedélyezzünk világos hátteret a szövegdobozra, 
valamint a nagyságát módosítsuk úgy hogy kicsit nagyobb legyen mint a dia felülete. 
Engedélyezzük Pörgés (Spinner) animációt a szövegdobozra. Módosítsuk úgy az 
animációt hogy minden betű külön animálódjon, valamint hogy a szöveg háttere (alakzat) 
ne kerüljön animálásra. Az animáció után a szöveg változzon halvány szürkére. Másoljuk 
az elkészített szövegdobozt és animációt kétszer, módosítsuk a szöveget Animáció próba 
2 és Animáció próba 3-ra, valamint az animációt úgy hogy egymás után induljonak. 
Mentsük el a bemutatót Animalas2Vegleges.ppt név alatt. 
2. Nyissuk meg az animalas1.ppt bemutatót, majd engedélyezzünk tetszőleges 
megjelenítési (halványítással), kiemelést és eltűnési animációt az egyes elemekre. 
3. Rendezzük sorba (a szövegnek megfelelően) az animalas2.ppt bemutató elemeit. 
 
Időzítéspróba 
 

Ha előre ki szeretnénk próbálni, hogy a vetítés diánként és összesen mennyi időt 
vesz igénybe, esetleg ehhez kívánjuk hozzáigazítani a vetítési beállításokat, akkor 
használjuk ki az időzítéspróba lehetőségeit a Diavetítés menü Időzítéspróba (Slide 
Show > Rehearse Timings) menüpontjával. Ekkor a vetítés úgy indul meg, hogy a 
képernyőn egy kis számláló is látszik, amely az időmérésen kívül a váltások rögzítésére is 
használható. 

 
53. kép 
Az időzítéspróba vetítésénel megjelenő panel 
 

 
 

FELADATOK 
 
1. Nyissuk meg az Animalas2Vegleges.ppt bemutatót, és engedélyezzünk tetszőleges 
időzítést az elemekre. Mentsük el a változásokat Animalas2Idozitve.ppsx név alatt. 
 

Audioklip 
 

 A különböző hangokkal érdekesebbé és színesebbé (állathangok, közlekedési 
eszközök hangjai, zeneszámok).  A gyakori és álandó hanghatások azonban zavarhatják 
az előadást és elvonhatják a hallgatók figyelmét. Ezért ajánlatos célirányosan használni 
ezeket.  

Az audioklippeket a Beszúrás menüszalag Audioklip ikonja segítségével tudjuk 
beszúrni. A háttértárunkról a Audioklip fájból (Sound from File) utasítás, vagy a 
ClipArtból a ClipArt-audioklip (Sound from Clip Organiser) parancs segítségével 
szúrhatunk be hangot.  
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54. kép 
A hang beszúrására szolgáló legördülő menü 
 

 
 

A háttértárról történő beszúrás mellett lehetőségünk van hang rögzítésére a 
Hangrögzítés (Record Sound) parancsával. A hangrgözítés mikrofon segítségével 
történik, vagy az aktuálisan lejátszott hang kerül rögzítésre.  
 
55. kép 
Hangrögzítés 
 

 
 

 
A diára beszúrt hangot ikon jeleníti meg. Ez az ikon a dián a vetítéskor is 

megjelenik. Az ikont a dián a Fogd és vidd módszerrel tetszőlegesen áthelyezhetjük. A 
hang lejátszását szerkesztés közben az ikonra duplán kattintva, vagy vetítés közben az 
ikonra egyszer kattintva indíthatjuk el.  

 
56. kép 
Az audioklippet jelképező ikon és a lejátszó 
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A beszúrt audioklip a Lejátszás (Playback) menüszalagon módosítható, amely az 
audioklipre klikkelve jelenik meg. Könyvjelzőket (Bookmark) tudunk a hanghoz 
hozzáadni, szerkeszthetjük a Hang vágása (Trim Audio) parancs segítségével, az 
elejéhez hangosodást, a végére pedig halkulást tudunk engedélyezni, módosítható a 
hangerő, valamint meghatározható az indítás módja.  

 
57. kép 
Az audioklip lejátszására vonatkozó beállítások 

 

 
 
A hanglejátszás indítására beállítást bármikor megváltoztathatja az Egyéni 

animáció munkaablakban. Jobb klikkelés után (az animációra) válasszuk a helyi menü 
Efektus beállításai (Effect Options) menüpontot. Az ezután megjelenő panelen a 
Effektus (Effect) fülön meghatározhatjuk (módosíthatjuk) a hang lejátszásának indulását 
(az elejétől, időzítve) és a hang leállítását (a következő klikkelés, az aktuális dia után, 
megadott számú dia után). 

 
58. kép 
Az Effektus beállítása panel, a hangok esetében 

 

 
 

 
FELADATOK 
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1. Hozzunk létre egy új bemutatót, 4 diával amelyeknek más-más hátterei vannak. 
Engedélyezzünk a diákra tetszőleges áttűnést. Az első diára szúrjuk be a 
AudioTrack.mp3 fájlot. Engedélyezzünk a fájl elejére hangosodást, a végére pedig 
halkulást (3 másodperc). Módosítsuk a fájl lejátszását úgy, hogy a 3. dia után álljon le a 
lejátszás. 
2. Szúrjuk be a gitar.wav fájlot, majd engedélyezzünk a lejátszásra folyamatos ismétlést. 
3. Szúrjuk be az AudioTrack.mp3 fájlot, majd vágjuk le a 0-15 másodpercig és az 1 
percen túl található részeket, engedélyezzünk könyvjelzőt a 25. másodpercre. 
 
Kísérőszöveg rögzítése 
 

A bemutatónkhoz saját készítésű kísérőszöveget tudunk készíteni a Diavetítés 
menü Kísérőszöveg rögzítése menüpontjára mutatva (Slide Show > Record Narration). 
A kísérőszöveg rögzítéséhez szükségünk van egy csatlakoztatott és megfelelően beállított 
mikrofonhoz. A klikkelés után megjelenő panelen be tudjuk állítani a mikrofon 
hangerejét, a rögzített hang minőségét (a minőségesebb a hangok több helyet foglalnak a 
háttértárunkon), meghatározhatjuk a kísérőszöveg elmentésének a helyét, illetve azt, hogy 
csatolja-e a kísérőszöveget a PowerPoint a bemutatóhoz. Az OK gomb lenyomása után a 
vetítés indul. A vetítéssel (animációkkal) összhangban a kísérőszöveget tudjuk rögzíteni. 

Az oktatásban a hagyományos bemutatónkat tehetjük színesebbé, valamint a 
nyelvórákon (kiejtés fontossága) használhatjuk a kísérőszövegek rögzítését. 
 
59. kép 
A Kísérőszöveg rögzítése utasítás beállításai 
 

 
 

 
 

FELADATOK 
 
1. Rögzítsünk tetszőleges kisérőszöveget a bemutatónkhoz. 
 

Videoklip 
 

A szöveg, a képek, a hangok és az animáció megjelenítésénél hatásossabb 
tudástransfert tesz lehetővé a videoklip beszúrása, amikor is a multimédia 
megjelenítésével több érzékszervre is hatunk (kép, mozgókép, szöveg és hang egyidejű 
megjelenítésével). Számos esetben csak ilyen módon tudjuk bemutatni az egyes 
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folyamatokat (belső égésű motor működése, veszélyes kémiai reakciók, 
atommaghasadás, csírázás, víz körforgása a természetben, stb.) 

Videoklip beszúrásához használjuk a Beszúrás menüszalag Videoklip parancsát 
(Insert > Video). A PowerPoint 2010-ben három féle videoklippet használhatunk. Ezek: 
Videoklip fájlból (Video from File), Videoklip webhelyről (Video from Web Site) és 
ClipArt-videoklip (Clip Art Video). 

 
60. kép 
A Videoklip beszúrása lehetőségei 

 

 
 
A videoklip beszúrása után megjelenik a lejátszó, valamint a videoklip külalakja a 

Formátum (Format) menüpont alatt formázható. Ezen a részen hasonló hatásokat 
tudunk engedélyezni a videora mint a képeknél. Módosítható a fényereje és a kontrasztja, 
a színe, sablon formájában felkínált Videostílusokat (Video Styles) tudunk elfogadni, 
módosítható a video alakzata, valamint a videoszegély. A Plakátterv (Set Poster 
Frame) opcióval meghatározható az a kép, amely a video lejátszása előtt jelenik meg a 
video felületén. 

 
61. kép 
A videoklip Formátum menüszalaga 
 
 

 
 
 
 
 
A Lejátszás (Playback) menüszalagon a videoklip lejátszására vonatkozó 

beállítások találhatóak. Hasonlóan az audioklippekhez, lehetőségünk van könyvjelző 
hozzáadására, a videoklip vágására, valamint fokozatos megjelenés és elhalványulás 
hozzáadására. Ugyanúgy mint az audklip szerkesztésénél, itt is lehetőségünk van a 
hangerőt és az indítás módját meghatározni. A teljes képernyős képekhez hasonlóan, a 
teljes képernyős videoklip is igen hatásos információközlési forma. Ezt a lehetőséget is 
ezen a szalagon a Teljes képernyős lejátszás (Play Full Screen) jelölőnégyzet 
engedélyezésével érhetjük el. 

 
62. kép 
A videoklip Lejátszás menüszalaga 
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A PowerPoint 2010 egyik újítása hogy a felhasznált audio- és videoklippek a 

PowerPoint fájlokba ágyazódnak be, és nem kell külön csatolni vagy másolni őket (a 
fájlok mérete jelentősen növekszik a video beszúrás után). A másik jelentős újítása ezen a 
téren az online videok beágyazásának a lehetősége, amelyeket továbbra is az internetről 
tölt be.  

 
Video beszúrása a YouTube-ról 

 
Keressük meg a felhasználni kívánt video a YouTube-on vagy másik 

videomegosztó portálon (videa.hu), majd klikkeljünk a Share or Embed this video, majd 
újra az Embed (Beágyazás) gombra.   

 
63. kép 
A videoklip beágyazási kódjának lekérése a YouTube oldalon 
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Ekkor létrejön egy több sor hosszúságú kód, amelyet a PowerPoint Videoklip 
webhelyről opcióra klikkelve tudunk bemásolni. A bemásolás után megjelenik a dián a 
video a hozzá tartozó lejátszóval.  

 
 
 

64. kép 
A videoklip beágyazási kód bemásolása 

 

 
 

65. kép 
Egy dia felületén megjelenő videoklip 
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FELADATOK 
 
1. Szúrjunk be egy mozgóképet, amelynél a hangot teljesen némítjuk és a lejátszás során 
teljes képernyőn mutatjuk be sundiszno.avi. Engedélyezzünk tetszőleges videostílust, 
valamint olyan videoeffektust amely illeszkedik a háttérhez. 
2. A második diára szúrjuk be ugyanezt a videoklippet. Vágjuk videoalakzatra, majd 
töltsünk le az internetről egy hasonló tartalmú képet és alkalmazzuk ezt plakátképként. 
3. Keressünk egy videomegosztó portálon „powerpoint fényképalbum készítés” 
kulcsszavakra videot. Ágyazzuk be ezt a videot egy tetszőleges bemutató tetszőleges 
diájára. 

A prezentációkészítés folyamán jelentkező hibák és nehézségek 

(Túl sok helyet foglal a háttértárunkon a prezentáció) 

Képek tömörítése  
 
A sok helyet elfoglaló prezentáció hátránya, a helyigény mellett, a hosszú ideig 

tartó megnyitás is (túl sok ideig tart a prezentáció betöltése). A “nagy” prezentáció oka 
leggyakrabban túl nagy felbontású képek használata, illetve audio- és videoklippek 
csatolása a prezentációhoz. 

A képek jól mutatnak a bemutatóban, de jelentősen megnövelik a fájlméretet. Ez 
ellensúlyozható egy kép Formátum menüjében található Képek tömörítése (Compress 
Pictures) funkciójának használatával, így helyet takaríthatunk meg a merevlemezen, 
illetve csökkenthetjük a betöltéshez szükséges időt.   

Nem minden képformátum optimizálható, illetve csak nagyon szerény 
eredménnyel. A vektorgrafikus képek (a legtöbb ClipArt) nem optimizálhatóak. Ellenben 
a nagy felbontású képek, például a fényképek jó eredménnyel optimalizálhatók (PNG, 
JPEG, TIFF és BMP fájltípusok). 

Az Alkalmazás erre a képre (Apply only to this picture) jelölőnégyzet 
segítségével beállítható, hogy az engedélyezett beállítások csak az aktuális képre, vagy a 
prezentáció összes képére lesznek engedélyezve. 

A Képek levágott részeinek törlése (Delete cropped areas of pictures) 
beállítással jelentős mértékben csökkenthető a fájlok mérete. Az opció kiválasztása majd 
a mentés után a bemutatónk már nem fogja tartalmazni azokat a képrészeket, amelyeket 
előtte levágtunk. 

A Kimenet (Target output) részen módosítható a tömörített kép minősége, 
illetve a minőséggel összefüggő rendeltetés. Nyomtatás (220 ppi) - Print, Képernyő 
(150 ppi) - Screen, E-mail (96 ppi) – E-mail és a Dokumentumbeli felbontás 
használata (Use document resolution). Ha a bemutatónkat kivetítésre szánjuk, akkor 
elegendő a Képernyő (150 ppi) beállítás, azonban prezentáció elmentése előtt ajánlatos 
teljes képernyőn (illetve a kivetítőn) leellenőrizni a képek minőségét. 
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66. kép 
A képek tömörítése párbeszédablak 

 

 
 
 

FELADATOK 
 
1. Szúrjuk be a fenykep.jpg képet egy üres bemutató első oldalára. Mentsük el Alap.pptx 
néven. Módosítsuk a bemutatót úgy hogy engedélyezünk tetszőleges hátteret, módosítsuk 
a kép méretét, vágjuk le a kép széleit és mentsük el Modositott.pptx név alatt. Tömörítsük 
a Modositott.pptx bemutatót képernyőre optimizálva és engedélyezzük a levágott részek 
törlését, majd mentsük el a prezentációt Tomoritett.pptx néven. Hasonlítsuk össze a 
fájlok méretét. 

Előkészítés CD-hez 

(A bemutató egyeses hangok és mozgóképek nem jelennek meg egy másik 
számítógépen) 

 
Tudjuk, hogy nem elég ha a bemutató az otthoni számítógépen látványosan mutat, 

és minden hang vagy mozgókép kiválóan működik, hiszen ez nem biztosíték arra, 
hogyegy másik gépen is hasonlóan fog megjelenni.  

A múltban gyakran okoznak gondot a médiafájlok. A mozgóképek (például az 
.mpg) és számos hangfájltípus csak csatolva van a bemutatóhoz, nem szerves része 
annak, ezért a bemutatók másolásakor ügyelni kellett arra, nehogy kimaradjanak az 
anyagból. Ez probléma a PowerPoint 2010-es verziójában megoldódott, ugyanis a 
médiafájlok beágyazódnak a prezentációkba. Hasonló problémát old meg a betűtípusok 
beágyazása fájlba opció is, amelyet az előzőekben ismertettünk. 

Az is előfordulhat, hogy a bemutatóhoz használt számítógépen nincs telepítve a 
PowerPoint, illetve hogy külső fájlokat használtunk. Habár a 2010-es verziótól a Fájl 
menüszalag Előkészítés CD-hez (File > Package from CD) parancs jelentősége 
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csökkent, még mindig nagyon igen hasznos opciónak bizonyul ahhoz hogy a bemutatónk 
szinte bármilyen számítógépen megtekinthető legyen. 

 
67. kép 
Az Előkészítés CD-hez parancs  
 

 
 
A parancs kiválasztása után meghatározhatjuk a CD elnevezését, valamint 

meghatározhatjuk a másolandó fájlokat. 
 

68. kép 
Az Előkészítés CD-hez párbeszédablak 
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A Beállítások (Options) beállítással meghatározhatjuk az előkészítés részleit, 

mint például a csatolt fájlok engedélyezését, a betűtípusok beágyazását és jelszóval is le 
tudjuk védeni prezentációt. 
 
69. kép 
Az Előkészítés CD beállításai 

 

 
 
A beállítások véglegesítésével azt kell kiválasztani hogy az elkészített bemutatót 

mappába vagy CD-re szeretnénk másolni. 
 

70. kép 
Másolás mappába párbeszédablak 

 

 
 

FELADATOK 
 
1. Szúrjunk be mozgóképet és zenét, majd végezzük el az előkészítés CD-hez műveletet, 
és válasszunk egy mappát. Keressük meg a mappát és ellenőrizzük, hogy oda kerültek-e a 
bemutatónk elemei 

Hivatkozások 

Az akciógombok és a hivatkozások igen széleskörűen tudjuk alkalmazni az 
oktatásban. Ezen eszközök segítségével webcímekre, fájlokra vagy az adott prezentáció 
tartalmán belül (tetszőleges) diákra tudunk ugrásokat végrehajtani. Hivatkozások 
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segítségével tartalomjegyzéket, a kezdőlapra visszaugrást segítő gombot vagy akár 
programozott oktatást tudunk megvalósítani. Szinte bármely objektumhoz tudunk 
hivatkozást rendelni (szöveg, kép, WordArt).  

Először ki kell választani az objektumat majd a helyi menüből, illetve a Beszúrás 
menüszalagról kiválasztjuk a Hiperhivatkozás (Hyperlink) parancsot. 

A Hivatkozás beszúrása (Insert Hyperlink) panelen a Létező fájl vagy weblap 
(Exiting File or Web Page) paranccsal fájlokra vagy honlapcímekre tudunk hivatkozni. 
A fájloknál az elérési útvonalat (d:\tanitokepzo\utasitas.doc) a honlapoknál pedig a 
webcímet (http://www.magister.uns.ac.rs) kell beírni vagy megmutatni.  

 
71. kép 
Hivatkozás beszúrása (Létező fájl vagy weblap) 

 

 
 
A Dokumentum adott pontja (Place in This Document) parancs segítségével a 

bemutatón belül tudunk más helyre ugorni. A Válasszon egy dokumentumon belüli 
pontot (Select a place in this document) ablakban egy másik diára tudunk eljutni. 
Kiválaszthatjuk a diát, ugorhatunk a bemutatónk Első diájára (First Slide), az Utolsó 
diájára (Last Slide) vagy pedig az aktuális diához viszonyítva a Következő dia (Next 
Slide) vagy az Előző dia (Previous Slide) hivatkozást választhatjuk. Az Előzetes kép a 
diáról (Slide preview) felirat alatt láthatjuk a kiválasztott diát (kicsinyítve). 
 
 
 
 
 
 
 
 
 
 
 

http://www.magister.uns.ac.rs
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72. kép 
Hivatkozás beszúrása (Dokumentum adott pontja) 

 

 
 
Az E-mail cím (E-mail adress) panelen a kiválasztott objektumhoz E-mail címet 

tudunk rendelni. Ezekre a címekre ha ráklikkelünk, akkor a levelezőprogramunk indul el,  
a megadott címmel (például: namesz@stcable.rs).  A panelen meg tudjuk határozni 
Tárgyát (Subject), amely tetszőleges (például: Észrevételek).  

 
73. kép 
Hivatkozás beszúrása (E-mail cím) 

 

 
 
A PowerPoint a weblapok címeit a helyköz lenyomása után önmagától értelmezi, 

ha az tartalmazza a megfelelő elemeket (az előtagot: „www.” vagy „http://” és a 
végződést például „.rs” vagy „.com”). Ugyanez a helyzet az elektronikus levélcímmel is. 

mailto:namesz@stcable.rs
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A szöveg kukacot (@) és a megfelelő végződést (például: „.net” vagy „.rs”). A 
hivatkozással azonban meg tudjuk oldani, hogy egy címtől eltérő szöveghez rendeljünk 
címet (például: Karunk honlapja szöveghez a vebcímet vagy Levél a készítőnek 
szöveghez a e-mail címet). A hivatkozásokat a kijelölés után a helyi menü Hivatkozás 
eltávolítása (Remove Hyperlink) parancsával tudjuk a hivatkozásokat törölni. 

 
FELADATOK: 
 
1. Készítsünk el egy elképzelt szemináriumi munka kezdőlapját, amelynél 
hivatkozásokkal csaoljuk az egyetemünk webcímét és saját mailcímünket.  
 
Műveletek 

 
 Gyakran előfordulhat, hogy a bemutatónk során hangokat szeretnénk 
hozzárendelni egy meghatározott képhez vagy akciógombhoz (közlekedési eszközök 
hangjai, állatok hangjai, stb), amelyek klikkelésre vagy az egér áthaladásakor indulnak el. 
Emellett különböző állományokat tudunk futtatni, valamint a vetítés is befejezhető az 
egyes opciók segítségével. 
 Az objektum kijelölése után a Beszúrás menüből a  Művelet (Insert > Action) 
paranccsal lehetséges. Ezután a Akcióbeállítás (Action settings) párbeszédablakban 
társítható a kívánt művelet a kijelölt objektummal. A panelen meg tudjuk határozni a 
Kattintásra (Mouse Click) és Áthaladáskor (Mouse Over) (az egérkurzor 
áthaladásakor az objektum felett). Mindkét fülnél ugyanazok a lehetőségek állnak a 
rendelkezésünkre.  
 A Hiperhivatkozás (Hyperlink to) legördülő menüben tudjuk meghatározni a 
linkelést. Itt kiválasztható az előző, következő, előző, utolsó dia, fájlra, webcímre vagy 
másik prezentációra tudunk hivatkozni. A Vetítés vége (End Show) utasítással lépünk ki 
a bemutatónkból. A Programindítás (Run program) résznél „exe” kiterjesztésű fájlokat 
tudunk indítani. A fájlokat a háttértárunkról a Tallózás (Browse) paranccsal tudjuk 
megnyitni. 

A Hanglejátszás (Play sound) jelölőnégyzet kijelölése után hangokat tudunk 
választani, amely a fültől függően kattintásra vagy áthaladáskor indul. A PowerPoint 
tartalmaz beépített hangokat (bomba, csengő, dobpergés, stb.), de az Egyéb hang (Other 
Sound) opcióval tetszőleges hangot tudunk kiválasztani a háttértárunkról. 

A Ha engedélyezzük a Kiemelés (Highlight click) jelölőnégyzetet, akkor az 
objektum színe megváltozik a meghatározott eseménykor (klikkelésnél vagy 
áthaladásnál). 
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74. kép 
Akcióbeállítások meghatározásra szolgáló panel 
 

 
 
FELADATOK 
 
1. Hozzunk létre egy objektumot, amely “exe” kiterjesztésű állományt indít (például: 
Word) 
2. Rendeljük a gitar.wav hangfájlot egy internetről letöltött képhez. Engedélyezzük a 
kiemelést  
 
Akciógombok  
 

Az akciógombok hivatkozások, amelyek hangot játszanak le vagy más programot 
(például egy exe fájlt) indítanak. Mozgóképek  és animációk vezérlésére is használhatók. 
Beszúrásuk a Beszúrás menüszalag Alakzatok (Insert > Shapes) parancsával 
lehetséges. Alapértelmezetten tartalmaznak utasítást (előző dia, következő dia, első dia, 
utolsó dia, stb.), de ezek módosíthatók a Művelet parancs segítségével. Az akciógombok 
előnye az hogy alapértelmezetten gomb hatású animációt tartalmaznak, amely klikkelésre 
indul el. 
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75. kép 
Akciógombok 

 

 
 

 
FELADATOK 
 
1. Szúrjunk be a hanszórót tartalmazó akciógombot. Csatoljuk a kanari.wav hangfájlot. 
2. Hozzunk létre egy öt oldalból álló prezentációt. Számozzunk meg az egyes diákat. 
Akciógombok segítségével (Vissza, Következő, Elejére, Végére, Kezdő dia) hozzunk 
létre egy a diák jobb alsó sarkába egy navigációs menüt, amellyel lehetőségünk lesz a 
bemutatónkban a tetszőleges diaváltásra. 
3. Akciógombok (Egyéni) segítségével készítsünk egy olyan feladatot, amelynél a helyes 
válaszra klikkelve megerősítés, a helytelen válaszra klikkelve pedig kiegészítést kapunk. 
 

Élőfej és élőláb 
 

Az élőfej és az élőláb funkciója és beszúrása nagyrészt megegyezik a Word 
szoftverben ismertetett opciókkal. A Beszúrás menü Élőfej és élőláb menüpontjából 
történik (Insert > Header & Footer). Ezután engedélyezhető a dátum, a dia számozása, 
valamint az élőfej és az élőláb szövege. 

 
76. kép 
Az Élőfej és az élőláb párbeszédablak 
 

 
 
FELADATOK 
 
1. Az aktuális bemutatónkra engedélyezzünk élőfejet és élőlábat, amely tartalmazza az 
időt és a dátumot, a dia számozását, valamint a következő szöveget: Készítette: Saját 
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nevünk. Engedélyezzünk olyan beállításokat, amely a címdián nem jeleníti meg az 
élőfejet és élőlábat. 
 

Diasorozatok nyomtatása 

A prezentációt elsősorban képernyőre (kivetítésre) tervezzük, mégis gyakran 
szükségünk van a papíron való megjelenítésre. A teljes diasorozatot vagy egyes diákat 
nyomtatni a Fájl menüszalag Nyomtatás menüpontjával tudunk (File > Print).  

A Példányszám (Copies) mezőben a másolatok számát tudjuk beállítani.  
A menüpont aktiválást követően kiválasszuk a Nyomtatót (Printer). A 

nyomtatókat tartalmazó legördülő menüben található a Nyomtatás fájlba (Print to File) 
beállítás. 

A Diák (Slides) mezőben pontosan meg tudjuk határozni, hogy mely diákat 
szeretnénk nyomtatni. A diák számát kell megadni. Ha több (nem egymás után található) 
diát szeretnénk nyomtatni, akkor vesszővel választjuk el a számokat (1,3,7). Ha egymás 
után következő diákat szeretnénk nyomtatni, akkor kötőjelet használunk (9-12). A két 
módszert tudjuk ötvözni is (2,4,6-12).  

A Nyomtatási elrendezés opciónál meghatározható az hogy hány dia kerüljön 
egy oldalra. Ajánlatos 3 diát választani, mert így megjelennek a jegyzetelésre használatos 
vonalak. 

Emellett meghatározható a nyomtatott diák színárnyalatai a következő 
eszközökkel: Színes (Color) visszaadja a bemutatónk összes színeit, a Szürkeárnyalatos 
(Grayscale) a színeket a feketévé, fehérré és a szürke különböző árnyalataivá alakítja. A 
Csak fekete-fehér (Pure Black and White) beállításnál a szoftver csak fekete és fehér 
színeket használ. 
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77. kép 
A nyomtatás előtt megjelenő panel 
 

 
 

FELADATOK 
 
1. Nyomtassuk fájlba az aktuális bemutatónkat úgy hogy három dia kerüljön egy lapra 

A diáinkon szereplő megfelelő színek kiválasztása 

A diáinkon szereplő színek érzéseket, hangulatot közvetítenek, a hagyományos 
kifejezési mód mellett. Ismernünk kell a színek jelentését, mivel segítségükkel 
felhívhatjuk a figyelmet a mondanivalónkra, megfelelő környezetbe tudjuk foglalni a 
tartalmakat. Készítettek egy kutatást arról, hogy különböző színek láttán mire 
asszociálnak az emberek:  

• Fekete - Nehéz, gyászos, hivatalos, halál, high-tech  
• Barna - Föld, egyszerűség, kert  
• Kék - béke, nyugalom, bizalom, biztonság  
• Lila - királyi, bölcsesség, spiritualitás, titok  
• Zöld - természet, környezet, egészség, hüllők, rovarok  
• Szürke - konzervatív, praktikus, megbízhatóság, biztonság, megfontolt  
• Piros - szenvedély, izgalom, szerelem, intenzív, hőség, aggresszió  
• Narancs - melegség, lelkes, színpompás  
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• Sárga - optimizmus, boldogság, idealista, képzelet  
• Fehér - tisztaság, erkölcs, tisztelet, egyszerűség 

 
A tervezéskor figyelembe kell venni: 

 
• A színek karakterisztikus hatását 
 

vörös – hangos,aktív,erőteljes,dinamikus;  
ibolya – melankónikus, szomorúságot árasztó  
sárga - cselekvésre ösztönző, irányító  
kék – hüvös,csillapító,távolságot adó, áttekinthetetlen 
 

• A színek asszociatív hatását:  
 

zöld színhez a természet,  
kékhez a víz, az ég,  
vöröshöz a tűz kapcsolódik a leggyakrabban. 
 

• A színek szimbólikus hatását:  
 

vörös általában a veszélyt, harcot jelenti,  
kék a ridegséget,nyugalmat szimbolizálja,  
sárga a derü a felszabadulás színe. 

Elkerülendő színkombinációk  

Vannak színkombinációk, amiket több okból is elkerülendőek a diák elkészítésénél.  

Piros és zöld - Ez a két szín teljesen üti egymást és nagyon nehezen lehet az egyik 
mellett a másikat olvasni. De van egy másik ennél sokkal komolyabb ok. Vannak 
emberek akik úgynevezett piros-zöld színtévesztők és egyáltalán nem látnak semmit a 
dián ha ez a két szín egymás mellett van. 
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78. kép 
A piros és a zöld szín összhatása egy dián 

 

 
 

Narancs és kék – Ez egy olyan párosítás, ahol a szemnek úgy tűnik, hogy az egyik 
szín vibrál a másik mellett és így nagyon nehéz elolvasni a szöveget vagy valamilyen 
grafikán megfigyelni a dián.  
 
79. kép 
A narancs és a kék szín összhatása egy dián 

 

 

Piros és kék – A két szín között nincs annyi kontraszt hogy jól olvashatóak 
legyenek egymás mellett, amikor pedig kivetítjük az előadásunkat a projektor még 
csökkenthet a kontraszton és egyáltalán nem látszik jól a szöveg. 
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80. kép 
A  piros és a kék szín összhatása egy dián 

 

 

Ajánlott színkombinációk  

  A jól bevált recept szerint két árnyalatkombinációt ajánlunk, mert kivetítve sem 
csalódunk bennük soha. Az egyik nagyon sötét háttéren nagyon világos betűket vagy 
grafikát használjunk. A másik, hogy nagyon világos háttéren, nagyon sötét betűket vagy 
grafikát használjunk.  

Sötét háttér világos szöveggel vagy ábrával:  

• Háttér – sötétkék (tengerészkék) vagy sötétlila (szinte feketébe hajló) 
• Szövegek és ábrák – fehér vagy citromsárga  
• Kiegészítő és nagyon kis mennyiségben használható színek még – vörös, zöld 

citrom, okker sárga, világos kék 

A sötétkék és a sötétlila színek jó alapot adnak a diáknak, a fehér és sárga színnek 
pedig elég nagy hozzájuk képest a kontrasztja , ahhoz hogy “világítsanak” a kivetített 
képen, és jól lehessen a szöveget olvasni. A kiegészítő színeket csak szavak vagy az ábra 
egyes részeinek kiemelésére használjuk de ne vigyük túlzásba mert nagy mennyiségben 
zavarhatják a szöveg olvasást.  
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81. kép 
A sötétkék  és a citromsárga szín összhatása egy dián 
 

 
 
82. kép 
A sötétlila és a fehér szín összhatása egy dián 
 

 
 

Világos háttér sötét szöveggel és ábrával:   

• Háttér – meleg bézs szín 
• Szöveg és ábra– sötétkék, fekete, sötét lila  
• Kiegészítő színek – sötétzöld, burgundi vörös 

  A bézs jó szín mert a barna meleg árnyalata és állítólag az embereknek a 
melegség és nyugalom jut róla az eszükbe. Szintén érdemes a bézshez képes nagy 
kontraszttal rendelkező színeket használni a szövegnál és ábránál. Itt is kerüljük a 
kiegészítő színek túlzott használatát.   
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83. kép 
A bézs és a fekete szín összhatása egy dián 

 

     
 

A gyakorlati tanácsok prezentációnk bemutatásához és a lámpaláz 
leküzdéséhez 

 
A szereplést megelőző lámpaláz és az előadás alatti idegesség hátterében a 

nyájösztön, a kisebbségi érzés és a kudarctól való félelem egyaránt állhat. Az emberek 
ösztönösen szeretnek elvegyülni a tömegben. Mások társaságában sokkal inkább a 
többséghez igazodnak, és azzal egyformán cselekszenek. Az ember nem szereti, ha 
kiválasztják, vagy ha egyedül áll. Ennek oka az elfogadottság és a beletartozás 
veleszületett igényében rejlik. Attól is félünk, hogy miként reagál a csoport, ha attól 
valamilyen formában elválasztanak. A kisebbségi komplexus az előadók legnagyobb 
ellensége. Az ember „önmagát hozza", és ha nincs tisztában saját értékével, ösztönösen 
ideges lesz. Senki sem szereti elveszíteni méltóságát, büszkeségét és emberi tartását. 
Sokak számára a beszédtartás létük legbelsejét fenyegeti. Valójában önmaguktól félnek - 
ezt a lelkiállapotot csak az önbizalom gyógyíthatja meg. Tudunk kell azonban, hogy az 
előadások előtti lámpaláz nem természetellenes. Sokszor a legtapasztaltabb előadók is 
feszültek az előadásuk előtt. Tudnunk kell, hogy a jól megszerkesztett bemutató is 
biztonságot sugároz, “megtámaszthatja” az előadásunkat. 

Az előadásokhoz kötődő stressz leküzdésére számos praktikus módszer ismert, az 
alábbiakban ezek közül emelünk ki néhányat:  
 
Bízzunk a közönség velünk szembeni jó szándékában! 
 
  A közönség azt akarja, hogy neked sikerünk legyen. Nem örülnének és esetleg 
kicsit zavarban is lennének, ha nem jól sikerülne a szereplésünk. A mi oldaladunkon 
állnak, tehát mosolyogjunk rájuk és alakítsunk ki velük jó kapcsolatot. 
 
Bízzunk önmagunkban! 
 
  A közönség felé akkor is sugározzunk bizalmat, ha nem is vagyunk annyira 
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biztosak a dolgunkban. Keltsünk csendes tekintély benyomást. Legyünk a „felelős 
ember". Sose mentegetőzzünk, és ne feltételezzük, hogy nem érdekes az, amit mondani 
akarunk. 

 
 
Ne vegyük magunkat túl komolyan! 

 
  Tényleg olyan sokat számít, ha valami nem sikerül? Mindenki kudarcot vallhat 
néha, és különben is, fog-e a közönség emlékezni a hibáinkra? A beszéd megtartása nem 
élet-halál kérdése. Érezzük magunkat jól! 
 
A „mintha - elmélet" 
 
  Tegyünk úgy, mintha nem félnénk - és nem fogunk félni. Vágjunk jó képet a 
dolgokhoz. Gondoljunk arra, hogy az érzés tettet szül, pl.: „félek" (érzés) - „kiszaladok" 
(tett). Ám a fordítottja is igaz: a tett érzést szül. Mosolyogjunk és jobban fogjuk 
magunkat érezni. Tegyünk úgy, mintha félelmek nélküli és magabiztos lennénk, és ez 
meghozza a bátorságot. 

 
Higgyünk abban, amit mondunk! 
 
  A dühös embernek nincs ideje idegeskedni, túlságosan belemerül az ügyébe 
ahhoz, hogy azon idegeskedjen, mit gondol róla a közönség. Tudjuk, hogy miről fogunk 
beszélni, bízzunk a témával kapcsolatos ismereteinkben, beszéljünk a tapasztalataink 
alapján, és saját lelkesedésünk hozzásegít az idegesség leküzdéséhez. 
 
Alaposan készüljünk fel a beszédünkre! 
 
  Az általunk tartott beszéd vagy előadás tényleg a „jéghegy csúcsa". Alaposan 
készüljünk fel rá. Dolgozzuk ki azt, hogy mit fogunk mondani és hogyan. Készítsünk 
jegyzeteket vagy vizuális anyagokat, próbáljuk el hangosan, amíg bizalmat nem kezdünk 
érezni magunkban és a beszédben. Mindig legyünk tekintettel a közönségre, és 
beszédünket az alkalomhoz igazítsuk. 
  
Próbáljuk el a beszédet 
 
Tükör előtt hangosan (esetleg videofelvétellel) próbáljuk el a beszédet. 
A bevezetést és a befejezést tanuljuk meg kívülről! 
Valószínűleg a beszéd elején leszünk a legidegesebb. A felszólalás előtt néhány perccel 
fejben fussunk át a bevezetésen. A közönség előtt várjunk ki, vegyünk mély levegőt, 
lassan álljunk fel, mosolyogjunk a közönségre, és lassan, érthetően mondjuk el a 
bevezető szavakat. A befejezés pedig az utolsó emlékképeket rögzíti hallgatóságban. 
 
Ne legyünk túl nagyra törőek 
 
  Minél hosszabban beszélünk, annál nagyobb a közönség elvárása velünk 
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szemben. Beszédeink eleinte legyenek egyszerűek, rövidek, és a témának csak a 
legfontosabb aspektusaira korlátozódjanak. Ha megnő a bizalmunk, és elsajátítjuk a 
technikát, alkalmasabbak leszünk a beszédtartásra. 
 
Mély levegővétel 
 
  A jó szerepléshez szükség van bizonyos feszültségszintre. Ez a feszültség a 
hegedű húrjaihoz hasonlítható: ha túl szorosak vagy túl lazák, a vonó által kihozott 
hangok torzak lesznek. Ezért a húrokat pontosan a megfelelő feszességre kell állítani. 
Hasonlóképpen, a mi adrenalin szintünknek is megfelelőnek kell lennie: ha túl alacsony, 
az előadás monoton és unalmas lesz; ha túl magas, megmutatkozik az idegességünk. Az 
előadás előtti néhány perces mély levegővétel a feszültség nagy részét leköti.  
 


